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1
INTRODUCTION TO COMPUTERS

1.1 History of Computers-Computer Generations-
Classification of Computers

1. History of Computers:

Computer is an Electronic device capable of high-speed
calculations and processing data with more accuracy. It is having
large storage capacity.

Computer history begins right from the ancient times, when
man calculated with fingers. The earliest device called “ABACUS”
(a wooden frame with bales or beads strung in parallel wires) was
used to make simple calculations. Later in 17" century, John Napier,
a Scottish Mathematician invented logarithms in 1614 and invented
a manual calculating device called as Napier Bone or Cardboard
multiplication calculator. Blassik Pascal invented the first
mechanical adding machine in 1642.

In nineteenth century, Charles Babbage professor at
Cambridge University is considered to be the father of computers.
He designed a machine called difference engine. Later George
Bool, an English Mathematician developed an Algebraic system,
which is called Boolean algebra. This is used for manipulation of
logical expressions. In 19" century, Dr. Herman Hollerith, developed
techniques and machines that had significant impact on the future
design of computers. He devised a “Consus Machine” which would
handle 50 to 80 punched cards per minute. He set up his own
company “Computing, Tabulating, Recording Company” which was
merged with others and become International Business Machines
(IBM). Today IBM is largest manufacturer of computers in the world.

2. Computer Generations:

Computers became commercially available during the early
1950’s and have experienced very significant technological
developments since that time. The changes and improvements
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that have been made since 1950 are described as generations of
computers.

A) First Generation Computers (1942-1955)

In this vaccum tubes were used to control and amplify
electronic signals. These computers could perform computations
in milliseconds. These are very large in size and produce large
amount of heat. It requires high maintenance (Air conditioning,
frequent failure of tubes). These are mostly used for scientific
computing rather than administrative applications.

Ex: ENIAC, EDVAC, EDSAC, UNIAC

B) Second Generation Computers (1955-1964)

These computers use transistors in place of vaccum tubes.
These are smaller in size, more reliable. It generates less heat.
The computational speed and storage capacity were increased.
Along with punched cards, magnetic tapes were used for 1/O
operations.

Ex: IBM 7000 series, ATLAS, LEO, UNIAC llI

C) Third Generation Computers (1964-1975)

In this integrated circuits (ICs) were used in place of
transistors. These were smaller in size as compared to previous
generation computers. These are more reliable and internal storage
capacity was further increased (16K to 128K). These computers
were able to reduce computational times from microseconds to
nanoseconds. Maintenance cost is low because hardware failures
are rare. These were widely used for various commercial
applications all over the world.

Ex: IBM 960, KL 1900, CDC 6000 and PDP Il

D) Fourth Generation Computers (1975 onwards)
Computers with Very Large Scale Integration (VLSI) were

termed as fourth generation computers. The size of the computers
was reduced and internal capacity increased (128k to 512k and
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above). These are much faster in computation than previous
generations. Hardware failure is negligible and hence minimal
maintenance is required.

Ex: IBM 30330, APPLE Il, FACT FINDER, HP 3000 and IDM

E) Fifth Generation Computers

Computers of future will be based on ULSI (Ultra Large Scale
Integration) based on Atrtificial Intelligence. In structure it will be
parallel (the present ones are serial) and will be able to do multiple
tasks simultaneously.

In nature, it will not do just data processing but knowledge
processing. And in architecture, it will have KIPS (Knowledge
Information Processing System) rather than the present DIPS/LIPS
(Data/Logic Information Processing System). Japan has already
started work in this direction few years back. It has chosen the
PROLOG (Programming in Logic) language as its operating
software and plans to have the final machine talk with human
beings, see and deliver pictures and hear the normal, natural
language.

3. Classification of Computers

Computers are classified into 3 categories depending on

1. The types of Computer
2. The purpose of Computer
3. The capacity of the Computer

1.The types of Computers: Electronic computers are classified
as Analog and Digital according to the manner they represent data.

a) Analog Computers: These computers operate on data in
the form of continuously variable. Measurable physical quantities
such as Temperature, Pressure, Revocations, Speed and Voltage.
Ex: Automobile speedometer, Slide rule

b) Digital Computers: These computers operate on
representation of real numbers and other Chargers coded
numerically. These have a memory and solve problems by counting
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precisely. Suited for data processing. More accurate than analog

computers.

2. The purpose of computers: Depending on the flexibility in
operations they are either general purpose or special purpose.

a) Special purpose computers: These computers solve a
restricted class of problems. It is designed to do only one job.
These computers are used to control automated manufacturing
process, to track aeroplanes or missiles.

b) General-purpose computers: These computers were
designed to solve a wide variety of problems. Ex: Payroll, Inventory

3. The capacity of computers: The capacity is expressed in
terms of volume of words that a computer can handle. The three
broad categories are Mainframes, Minis, and Microcomputers.

a) Mainframe computers: These are large characterized by a
separate processor for computing and handling large volume of
data. They can support smaller computers in a Network and Time-
sharing systems.

b) Mini computers: These are having smaller capacity with
more compact.

c) Microcomputers: These are built on microprocessors. These
are much faster, compact in size, storage from 4k to 128k.

1.2 Basic Computer Architecture-Input and Output devices-
Identify different peripherals of computer

1. Basic Computer Architecture:

All computers perform the following five basic operations:
1.Inputting 2. Storing 3.Processing 4. Outputting 5. Controlling
The basic internal organization of all computers is one and same.
Any computer system consists of three distinct units. These units
are
1. Input unit 2. Central Processing unit 3. Output unit
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These units are interconnected by electrical cables to permit
communication between them. This allows the computer to function
as a system.

1. Inputunit: Acomputer must receive both data and program
statements to function properly and be able to solve problems.
The method of inputting data and programs to a computer is
accomplished by an input device called input unit. Computer input
devices read data from a source, such as magnetic disks and
translate that data into electronic impulses for transfer into the
CPU. Some typical input devices are keyboard, mouse, and
scanner.

2. Output unit: The results of the processed data are sent from
the CPU to an Output device to show to the outside world. Some
typical output devices are floppy disk, hard disk, video display,
printer, etc.

3.  Central Processing Unit: Itis called as the brain of computer
system. It takes data or information from input unit and process
the data and the results are sent to output unit. It consists of a
Control Unit, Arithmetic logic Unit (ALU) and Storage Unit .The
control unit maintain order of operations and sends the appropriate
electronic impulses to ALU and storage sections so that they can

arry out the instructigrs: ms ari i al
gperations. The ge unitis used to sf a and instructions,
intermediateresults ¢fprocessing-and-also the-H

CcRhU
INPUT UNIT STORAGE UNIT OUTPUT UNIT
CONTROL UNIT
ALU
Fig.1.2.1

2. Input and Output devices:
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1. Input device: This is used to supply data and programs to
the computer system. These read data from a source such as
magnetic disks and translate that data into electronic impulses for
transfer into the CPU. Ex: Keyboard, MICR, OMR, OCR
Keyboard: This is used for typing, speed cannot exceed 200
characters per minute. It generally consists of alphanumeric keys,
Cursor control keys, and Function keys.

MICR: In this the characters are printed on documents with
magnetizable ink. This enables a magnetic ink reader to recognize
the characters for input to the computer. These are generally used
on Bank Cheques and Postal Orders.

OMR: Optical Mark Recognition has been in widespread use
since1960 for a wide variety of applications. Small black marks
are printed on documents and is a flexible system because the
value or meaning of a mark is unique to the particular type of
document.

OCR: These documents are clearly understandable to every one.
Hand printing requires no special equipment or expertise other
than reasonable care.

2.  Output device: This is used to take results of processed
data and shows to the outside world. These results are transferred
from the output storage area onto an output medium such as floppy
disk, hard drive, video display, printer, and so on.

MONITOR: It is visual display unit, which displays data with the
help of “Cathode Ray Tube” (CRT). Monitors have 24 rows and 80
columns. There are 3 types of monitors: Monochrome, RGB, and
Colour Monitor.

PRINTER: This is used to print data on hard copy like paper. There
are various types of printers available like Dot matrix, Laser printer,
Ink jet printer, etc.

3.Different peripherals of Computer System
The various input /output devices and auxiliary storage units of a

computer system are called as peripherals. The following are the
various peripherals generally used for a computer system:
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1.Keyboard: This is used to supply data to the computer system
by typing. Its speed cannot exceed 3 characters per second. This
consists of alphanumeric keys, cursor keys and function keys.

2.Mouse: This is a hand-held input device which when run along
the table causes the cursor to move correspondingly on the screen.
A mouse is a convenient way of selecting parts of display without
having to use the keyboard. A mouse may either may be attached
to the VDU by a lead or be unattached and operate by ultrasonic.

3. Joystick: Itis a small vertical stick attached to the tracking
ball for easier mechanical movements. It is used chiefly in games.

4.  Monitor: Itis used to display data on screen with the help of
cathode ray tube. It acts both as input and output device.

5. Printer and Plotter: Itis used to print the data on to a hard
medium like paper. Plotters are used for graphic output and are
used in applications like drawing technical diagrams.

6. Hard disk: It is used to store programs (software), data in a
computer system. This is fixed inside the CPU box. Its storage
capacity is very large. Minimum hard disk storage capacity is 20
MB.

7. Modem: This is a modulator-demodulator used to convert
digital signals to be communicated over an analog channel such
as telephone line to sine waves at the sending end and back to
digital signals at the receiving end. This is generally used for Internet
connection.

8. Motherboard: It is a printed circuit board placed in CPU.
It is connected to all other components like RAM, processor,
hard disk

1.3 Memories-Storage media
Computer memory is a device or medium that can store programs,

data and instructions. A memory is made up of a large number of
cells with each cell capable of storing one bit. This can be divided
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> —»| Memory
processor
Magnetic
Disks CPU Cache
Memory
_ Secondary Memory

into internal or primary memory, external or secondary memory.
The memory is generally measured in bytes. The memory hierarchy
Is shown below :

Fig. 1.3.1

1. Primary Memory: Itis made up of several small storage areas
called locations or cells. The data and instructions must flow into
and out of primary storage. The instructions retained in chips can
initiate 1/0O operations and processing tasks. Two important chips
are used in computers for their primary storage. They are the RAM,
ROM chips.

Random Access Memory (RAM) provides access to read and
write the data from their bit cells. This memory in volatile (caused
when the power cuts off). Also known as temporary storage. It is
available for the user to store the data and instructions at the time
of the execution and can be permanently stored by using a backing
storage media.

Read Only Memory (ROM) is a non-volatile memory in which
all cells are set permanently during manufacturing. It holds the
permanent instructions that are needed to the computer all the
time it is switched on. The mathematical equivalents, square roots,
algorithms, etc. are all set in the ROM storage. An extension of
ROM is PROM (Programmable Read Only Memory) and EPROM
(Erasable Programmable Read Only Memory).

2. Secondary Memory: It is an external storage unit available for
the computer system. Data are stored in them in binary codes and
are made available to the main storage, when needed. The various
memory devices used for secondary memory are:
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a) Floppy disks b) Winchester disks c) Optical devices
d) Tape devices e) Hard disks

The total access time to read or write on the magnetic disk is
made of two components: Seek time and rotational delay time.
Seek time is the time used in moving the read/write heads from
one position to another. Rotational delay occurs because the data
we want may not be directly under the read/ write heads, even
though they are located over the correct track. We have to wait for
the disk to revolve to the beginning of the desired data. Secondary
Memory is considered as a relatively long term, non-volatile storage
of data outside the CPU and primary storage. This would make
users to store information outside the computer in a non-volatile
state and to store large volumes of data.

3. Cache Memory: It is a special very high-speed memory used
to increase the speed of processing by making current programs
and data available to the CPU at a high speed. The cache memory
synchronizes the speed difference between main memory access

ime-and progesser speed. Fig—1-3-2-showsthreetevetierarchy,
which indigdeq cache memoyy: —»
“—

CPU Cache Main Secondary
Memory Memory
Fig. 1.3.2
1.4 Types of Software — Types of Languages — Operating
systems

1. Types of Software

Software is a general term for a set of instructions that controls
the activity of processing by the computer or communications
network. Software package is an application, which focuses on a
particular subject, such as word processing and is sold to business
and the general public. All software packages are accompanied
by documentation, which is instruction manual for the software. It
is a technical, detailed written description of the specific facts of a
program. Computer software is normally classified into two broad
categories: application software and systems software.
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a) Application software: It is a set of one or more programs
designed to carry out operations for a specified application. For
example, a payroll package produces pay slips and an application
package for processing examination results produces mark sheets.
Specific purpose application packages have also been developed
for specialized areas, such as banking, hospital administration,
insurance, publishing, manufacturing, etc.

b) Systems software: Itis a set of one or more programs, designed
to control the operation of a computer system. They are general
programs written to assist humans in the use of the computer
system by performing tasks, such as controlling all of the
operations, required to move data into and out of a computer and
all the steps in executing an application program. This support the
running of other software, communicate with peripheral devices
(printers, card readers, disk and tape devices, etc.). It also supports
the development of other types of software and monitors the use
of various hardware resources (memory, peripherals, CPU, etc.).

2. Types of Languages: Computer language is a system of
communication used to communicate between people and the
computer. With this, a programmer tells a computer what he wants
to do. Computer languages are classified into: Machine Language,
Assembly Language and High-level language.

a) Machine Language: This is the fundamental language of a
computer and is normally written as strings of binary 1s and Os. It
is recognized and converted by computer system into the electrical
signals needed to run the computer. Programs written in machine
language can be executed very fast by the computer. Writing a
program in machine language is so difficult and time consuming
thatitis rarely used today. It is difficult to correct or modify machine
language programs.

b) Assembly Language: This is a low-level programming language
in which mnemonics are used to code operations and alphanumeric
symbols are used for addresses. This language substitutes letters
and symbols for the numbers in the machine language program.
The translator program, which translates as assembly code into
the computer’s machine code is called an assembler.
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A symbolic program written by a programmer in assembly language
is called a source program. After the source program has been
converted into machine language by an assembler, is called as
object program.

c)High-level Language: This is basically symbolic language
that use English words and mathematical symbols. This is
a programming language whose structure is application
oriented and is independent of the structure of the computer.
Each statement of such a language is translated into many
machine language statements.

3. Operating Systems: A set of programs that is used to
manage the various resources and overall operations of a
computer system. Its prime objective is to improve the
performance and efficiency of a computer system. Thus, an
operating system is responsible for the smooth and efficient
operation of the entire computer system. It makes the
computer system user friendly. The operating systems
perform the following functions:

Processor Management — assignment of processors to
different tasks being performed by the computer
system.

Memory Management — allocation of main memory and
other storage areas to the system programs as well as
user programs and data.

Input/Output Management — coordination and
assignment of the different input and output devices
while one or more programs are being used.

File Management — the storage of files on various
storage devices and the transfer of these files from one
storage device to another.

It also maintenance of internal clock and log of system
usage for all users. It also facilitates easy
communication between the computer system and the
computer operator. It interprets the commands and
instructions.

Fig.1.4.1 shows, the OS tends to isolate the hardware from
the user. The user communicates with the OS, supplies
application programs and input data, and receives output
results.
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Users

Users

ApoPRUSAERMERSGRIAMS

Operating System

Hardware

Fig. 1.4.1

Operating systems were designed as single user OS and multi-
user OS. MS-DOS is a single user OS, which does not allow two
programs, stored in memory to run concurrently protected from
one another. MS-DOS is character user interface. UNIX, MS-
WINDOWS, OS2 are multi-user OS. These are Graphic user
interface.

1. Explain the history of computers.
2. Explain the generations of computers.
3. Draw block diagram of computer. Explain the functions of

each unit.

4. Explain the functions of computer peripherals.



EXERCISE

2
MS-DOS

2.1 System files-Naming of files-Wild card characters
1. System files

MS-Dos means Micro Soft Disk Operating System, which is
developed by Micro Soft Company in Assembly language in the
year 1980. Dos act as an interface between the user and the
computer. Itis a set of programs that manages computer resources,
that the computers can be used more efficiently. MS-DOS performs
the following tasks:

a. Itlooks packages like WordStar, Dbase, Lotus, etc.

b. Itallows us to create program and data files and saves them
on disk or floppy under the file name we give.

c. It copies files from floppy to disk or disk to floppy, etc.

d. It allows us to print files on printer.

The loading of operating system in the computer memory is
called Booting. There are two types of Booting:

a. Cold Booting: This happens when you switch on the
computer.

b.  Warm Booting: This happens when the computer is already
switched on. Warm booting is done by pressing Reset button or
by pressing Ctrl+Alt+Del keys simultaneously.

There are three System files in MS-Dos.

1. COMMAND.COM
2. 10.SYS
3. MSDOS.SYS

I0.SYS & MSDOS.SYS are called as hidden files, which mean
the files, which exist physically but not visible. When we execute
the DIR command, except COMMAND.COM the remaining system
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files are not displayed. The hidden files are the main DOS files
which will always interact with BIOS and there by perform the
operations. The COMMAND.COM is one of the DOS files, which
contain INTERNAL commands. The commands, which are not
present in the COMMAND.COM, are known as EXTERNAL
COMMANDS.

2. Naming of files

DOS maintain our programs, data on disk as files. The files
will have a unique name for identifications. The name is given by
the creator of the file (i.e. yourself), according to the rules of DOS.
The rules are as follows:

1. The file name can be 1 to 8 characters in length.

2. The filename can contain alphabets (A-Z), numbers (0-9)
and special characters like _ (underscore).

3.  There should not be spaces in between.

4.  The file may have three-character extension, after main file
name, followed by dot. Ex: Hari_2005.dat, October. PAY,
MY.DOC

2. WILDCARD CHARACTERS

DOS supports two wildcard characters i.e.? and *, that allow you
to specify a group of file names. ? is used for a single character in
the specified position, * is used for set of characters, starting at
the specified position within the filename or extension.

Ex:

1. DIR*.COM — This lists all files with any primary name and
with Extension COM.

2. DIRA*. * ——Lists all files that start with A.

3.  To see files with first two characters BL, third changing, and
next two characters ND. The command is DIR BL? ND. *.

This displays
BLAND.EXE BLIND.COM
BLOND.EXE BLIND.COM

Some list of the file name Extensions:
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1. .DOS — DOCUMENT FILES

2. .BAS — BASIC FILES

3. .COB — COBOL FILES

4. PRG — PROGRAMMING FILES

5. .DBF — DATA BASE FILES

6 PAS — PASCAL FILES

7. EXE — EXECUTIVE FILES

8. SYS — SYSTEM FILES

2.2 Practice on Internal commands

INTERNAL COMMANDS: The internal commands are those
commands, which are memory resident. They are automatically
loaded when the DOS is loaded. The following are the various
types of internal commands:

1. DATE 2. TIME 3.CLS 4.VOL 5.VER
6. REN 7.COPY 8.DIR 9.TYPE 10.MD
11.CD 12.RD 13. PATH 14. PROMPT

15. ECHO 16. DEL 17.COPY CON 18. ERASE

1. DATE: Display or sets the systems date

Syntax: DATE [MM/DD/YY] — If you invoke DATE command
without parameters, DOS displays the current system date and
prompts you to enter a new date. Dates are accepted using the
format MM/DD/YY.

2.TIME: Displays and allows changes to the system time.
Syntax: TIME [hh:mm:ss: cc] (A)/(P) — If you invoke TIME without
parameters, it displays the current system time and prompts you
to enter a new time.

3. CLS: ltclears the screen. Syntax: CLS ——The cls command
is invoked without parameters, it will erase all characters on the
screen and displays the Dos prompt.

4.VOL: Displays the disk Volume label. Syntax: VOL (drives:)

5.VER: Displays the current DOS version number. Syntax: VER
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6.REN: It changes the file name with a new file name.

Syntax: REN (drive/path) <old file name(s)><new file name(s)>
Ex: C>REN hari.doc kiran.bas ——It renames hari.doc file as
kiran.bas

7.COPY: Copies and combines files. Can overwrite or erase data.
Syntax: COPY <source file>< target file>

8. DIR: Displays a list of files in a directory

Syntax: DIR (drive:\path\file(s)) (/options)

/P:  Displays the list of the files in the directory page by page.
/W: Causes only files and extensions to be listed, in the wide
format with as many as five file names per line.

/S: Displays files in all sub-directories nested below, the specified
directory.

/Alt: Displays hidden files.

/B:  Displays files and directory names only.

/L:  Displays file names in lowercase.

/O: Lists files in sorted order.

9. TYPE: Displays all files on drive, if you give a file name it will
display the contents of the file.

10. MD or MKDIR: It creates a new subdirectory. Ex: MD raja —
It creates a directory with name raja.

11.CD or CHDIR: It will move to that directory

12. RD or RMDIR: It will remove empty subdirectories.

13. PATH: It looks for program files on the sub-directories

14. PROMPT: It changes the appearance of the DOS system
prompt. Syntax: PROMPT <prompt string>

SS-Dollar sign SD-Current date  ST-Current Time

15. ECHO [on/off]: The prompt will not be displayed on the screen.

16. COPY CON: We can create a new file in DOS.
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17. ERASE: This is used to delete the files.
18. DEL: It deletes one or more files.

2.3 Practices on External Commands

External Commands are those commands whose files have to
present in the working area. The following are the External
Commands:

1. APPEND 2. HELP 3. MORE 4. PRINT
5 REPLACE 6. RESTORE 7.SYS

8. UNDELETE 9.FORMAT 10. UNFORMAT
11.TREE 12. MODE 13. DISKCOPY

14. CHKDSK 15. BACKUP 16. ATTRIB

17. XCOPY 18. COMP 19. FIND 20. LABEL

1. APPEND: Establishes a sub directory search path for data
files.
Syntax: APPEND [source drive:\path) (; additional drive) (\options)
Options: /E  Stores the search path within the dos environment
/X Allows additional DOS commands to access the data search
path.

2. HELP: Displays short summaries of command syntax.

3. LABEL: Adds or modifies a disk volume label.
4. MORE: It displays the output one screen at a time.

5. PRINT: It prints series of files in background while you continue
to work with dos. Options are B-specifies the size in bytes of the
printer buffer, D-specifies the output name, M-Specifies the
maximum number of internal clock ticks DOS will take to send a
character to the printer. Q-specifies the maximum number of files
to be allowed in print queue.

Filename/c — Removes the indicated file name from the print
queue.

Filename/p —Adds the indicated file name to the print queue.
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6. REPLACE: Re quire two parameters source file name and target
file name. Options: /A —Adds files. /P —Displays prompt asking
you to confirm each copy before copying the file to the target. /R
—Disables overwrite protection for read-only files on the target.

7. RESTORE: Restore files from disks making use of the backup.
It requires two parameters a source drive where the backup files
are stored and a target drive usually hard disk.

Options: /A — mm-dd-yy forces restoration of only those were
modified on or after the specified date. /D — Displays files name
on the backup disk but do not restore them. /E —hh-mm-ss forces
restoration of those files modified at or earlier than the specified
time. /M — Restores only those files that were modified since the
last backup was made. /N — Restores only those files that were
deleted since the last backup.

8. SYS: Copies DOS system files to a new disk.

9. UNDELETE: Recovers accidentally deleted files. Syntax:
UNDELETE (drive path) file(s) (\options). Options: /DT — Forces
DOS to use a delete tracking file to locate and recover deleted
files. /ALL — Invokes automatic undelete and renaming of all
specified files.

10. FORMAT: Prepares a blank disk for receiving and storing data.
Or creates a new blank disk from a used one. Syntax: FORMAT
target drive: (/options) Options: /L — Formats a double disk as a
single sided disk. /B — Formats a disk so as to leave room for the
system files, although system files are not copied. Cant be used
with the /T or /S options. /S —Transfers DOS system files to the
formatted disk. /U — All data on a previously formatted disk is
destroyed, and you will not be able to unformat this disk later.

11. UNFORMAT: Recovers files from an accidental disk format if a
disk has been accidentally formatted. Syntax: UNFORMAT
drive:(options). Options: L lists the existing partitions, but does
not restore them. U — Restores the disk without using the image
file.
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12. TREE: Displays the subdirectory structure of a specified drive.
Syntax: TREE (drive:\path) (options). Options: F — Includes the
file name in each subdirectory. A— Displays the subdirectory using
standard ASCII characters rather than graphic characters. This
can speed up printing.

13. MODE: Performs various functions relating to the transfer of
data between the processor, the screen, the printer and keyboard.
It sets the parallel mode. It also sets serial communication protocol.
It shifts the screen left or right.

14.DISKCOPY: Copies the contents of a floppy disk to another on
a track-by-track basis. Syntax: DISKCOPY (source drive:) (target
drive) (options)

Options: /V — Performs a validity check on the data copied to the
target disk.

15. CHKDSK: Analyses, diagnosis and optionally corrects common
hard disk errors. Reports on the status of files on disk.

Syntax: CHKDSK (source drive:\path\file(s)) (options)

Options: /F — Enables auto-correction mechanics

16. BACKUP: Backs up one or more files from one disk to another.

17. ATTRIB: Displays or changes file attributes, read only —r,
archive —a, hidden —h, or system-s.

18. XCOPY: Copies files (except hidden and system files) and
directory trees. Syntax: XCOPY <source file> < destination file> (/
AIM)(/D: DATE)

IA — archive bit

/m — archive bit back up
/d: date on or after

p — prompt

Is — sub directories

le — copy empty directory
v — wait prompt

19. COMP: Compares the contents of the two files or sets.

20. FIND: Searches for a text string in a file (s) .
/c displays only a count of number of lines that contains the
string.



/n displays the line number that includes the string
/v displays all the lines that do not contain the string
/; Ignore the case of letters during the search

3
MS-Windows

3.1 Practice on elements of Windows-98 like My Computer,
My Documents, Internet Explorer, Network Neighborhood,
Recycle Bin, My Briefcase, etc.

1. Practice on elements of Windows-98

Windows is an extremely good looking and versatile package
from Microsoft. The launch of Windows 3.0 in 1989 caused a
revolution in the world of GUIs (Graphic User Interface).

1. My Computer: It displays the files and folders present in the
Computer system. It contains the partitions made to the hard disc
(i.e. different drives), floppy drive, and compact disc. It also contains
control panel, which customizes the appearance of desktop and
configures the computer system. It allows us to set system
properties like system configuration details, network identification
details, configuration of hardware, user profiles which contain
desktop settings and other information related to logon. It also
having advanced options like performance- which specifies how
applications use memory which affects the speed of your computer,
Environment variables — which tell your computer where to find
certain type of information, Startup and Recovery — which tell your
computer how to start and what to do if an error causes your
computer.

2. My Documents: A desktop folder that provides you with a
convenient place to store and manage documents, graphics, or
other files you want to access quickly. When you save a file in a
program such as WordPad or paint, the file is automatically saved
in My Documents, unless you choose a different folder. On your
desktop, it is represented by an icon of a folder with a sheet of
paper in it.

Even though My Documents is the default storage location for
several programs, your documents are not stored in the same My
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Documents folder as another user’s if there are multiple user
accounts on the computer. Each user has a My Document folder
located in the Documents and Settings \ username folder. You can
change the location of you're my Documents folder by right-clicking
My Documents on the desktop, and then clicking Properties. In
the My Documents Properties dialog box, type or browse (click
Find Target) for the path and folder name where you want to store
you're my Documents folder. My Documents also contains the My
Pictures folder, which is the default storage location for your pictures
when you save them from your digital camera to your computer.

3. Internet Explorer: It makes it easier to get the most from the
World Wide Web, whether you are searching for new information
or browsing your favorite Web sites. And built-in IntelliSense
technology can save you time completing routine Web tasks, such
as automatically completing Web addresses and forms for you,
and automatically detecting your network and connection status.

When you start typing a frequently used Web address in the
Address bar, a list of similar addresses appears that you can
choose from. And if a Web-page address is wrong, Internet
Explorer can search for similar addresses to try to find a match.

Search for Web sites by clicking the Search button on the
toolbar. Then in the Search bar, type a word or phrase that
describes what you're looking for. When your search results
appear, you can view the individual Web pages without losing
your list of search results.

You can also search directly from the Address bar. Just type
common names or words, and Internet Explorer can
automatically take you to the site that most likely matches what
you are searching for, and list other likely sites as well.

Go to other Web pages similar to the one you are viewing,
without even doing a search. Just use the Show Related Sites
feature.

Once you're on a Web page, Internet Explorer can help you
complete entries in any kind of Web-based form. Start typing,
and a list of similar entries appears that you can choose from.

Browse through a list of Web pages you recently visited by
clicking the History button on the toolbar. In addition you can
rearrange or search the History list.
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Listen to broadcast and Internet-only radio stations while you
browse. Choose from a wide variety of music and talk radio
stations, and add them to your Favorites list. The radio toolbar
is available in Internet Explorer when you install Windows Media
Player.

Put shortcuts to your most-used Web pages on your Links bar
for quick access.

Add other frequently visited Web pages to your Favorites list
for easy access. Organize your favorite items by using folders,
and sort them in the order you want them.

Choose from your favorite search providers and keep them
handy for all your searches.

Take your favorite Web pages with you: to another computer
or browser, or to share with your friends. You can even import
bookmarks from Netscape Navigator.

Mark your favorite Web pages for offline reading, and then
view those pages when you're not connected to the Internet.
You can update the content any time you're connected, or use
a schedule to automatically update it.

Switch easily between different types of Internet connections
without reconfiguring your settings.

Using Content Advisor, you can screen out objectionable
content by using industry-standard ratings that have been
defined independently by the Platform for Internet Content
Selection (PICS) committee.

Using security zones, you can set different levels of security
for different areas of the Web to help protect your computer.

Using the optional Microsoft Wallet, you can store your personal
credit-card and shipping-address information on your computer,
and take advantage of secure providers when you connect to
Web sites.
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If your Web browsing takes you to sites written in numerous
languages, Internet Explorer can update your computer with

the character sets you need to view these sites correctly.

The Internet Connection wizard provides you with an easy way to
get connected to the Internet. Whether you've never explored the
Internet before or have spent many hours online, the Internet
Connection wizard can help you set up a connection.

For new Internet users, the Internet Connection wizard creates an
Internet connection for you, and then displays a list of Internet
service providers (ISPs) and information about their services. You
can sign up for a new account by clicking an ISP in the list.

If you already have an account with an ISP and want to create an
Internet connection to your account, the Internet Connection wizard
collects all the necessary information from you and then creates
the connection.If you are not already running the wizard, you can
start it from Internet Explorer as follows:

1. Onthe Tools menu in the browser, click Internet Options.
2.  Click the Connections tab, and then click Setup.
3.  Follow the instructions on your screen.

4. My Briefcase: If you frequently work on files outside your main
computer (using a portable computer, for example), you can use
Briefcase to synchronize the files with their counterparts on your
main computer when you finish working on them. When you
reconnect your portable computer to your main computer (or insert
a removable disk containing the modified files), Briefcase
automatically updates the files on your main computer to the
modified versions. You do not need to move modified files out of
Briefcase or delete the existing copies on your main computer.

Briefcase stores files and displays their status. For instance, it can
show you whether a file is linked to the original file on your main
computer, or whether it is an orphan file. This information helps
you keep your files organized and prevents you from accidentally
deleting or copying over the most recent version of a file.
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Briefcase is the best tool for you if you frequently transfer files
between computers using a direct cable connection or a
removable disk. Using Briefcase, you can synchronize the files
you modified on another computer with their counterparts on
your main computer. You can keep your files organized by
creating multiple briefcases.

Offline Files is the best tool for you if you want to work with
shared files on a network. Using Offline Files, you can make
changes to shared files while disconnected from the network
and then synchronize them the next time you are connected to
the network.

To find the copy of the file that is outside Briefcase (which is
the counterpart to the copy that is stored in Briefcase), on the
Update Status tab, click Find Original.

If you want to view the status of the files that are stored in
Briefcase and the status column does not appear in the right
pane of the Briefcase window, on the View menu, click Details.

To check the status of files in Briefcase

1. Open Briefcase, and click the file you want to check.
2. On the File menu, click Properties.
3. Click the Update Status tab.

5. Recycle Bin: The Recycle Bin provides a safety net when
deleting files or folders in Windows. When you delete any of these
items from your hard disk, Windows places it in the Recycle Bin
and the Recycle Bin icon changes from empty to full. tems deleted
from a floppy disk or network drives is permanently deleted and
are not sent to the Recycle Bin.

Items in the Recycle Bin remain there until you decide to
permanently delete them from your computer. These items still
take up hard disk space and can be undeleted or restored back to
their original location. When it fills up, Windows automatically
cleans out enough space in the Recycle Bin to accommodate the
most recently deleted files and folders.
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If you're running low on hard disk space, always remember to empty
the Recycle Bin. You can also restrict the size of the Recycle Bin
to limit the amount of hard disk space it takes up.

To change the storage capacity of the Recycle Bin

1.  On the desktop, right-click the Recycle Bin icon, and then
click Properties.

2. Move the slider to increase or decrease the amount of disk
space that is reserved for storing deleted items.

A deleted item that is larger than the storage capacity of the
Recycle Bin will not be saved. It will be permanently deleted.

If you want to use different Recycle Bin settings for different
drives, click Configure drives independently, and then click
the appropriate drive tab to change the Recycle Bin settings
for that drive.

If you want to use the same Recycle Bin settings for all drives,
click Use one setting for all drives.

To delete or restore files in the Recycle Bin

1.  On the desktop, double-click Recycle Bin.

2. Do one of the following:

o To restore an item, right-click it, and then click Restore.

o To restore all of the items, on the Edit menu, click Select All,
and then on the File menu, click Restore.

o To delete an item, right-click it, and then click Delete.

o Todelete all of the items, on the File menu, click Empty Recycle
Bin.

Deleting an item from the Recycle Bin permanently removes it
from your computer. Items deleted from the Recycle Bin cannot
be restored.
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You can also delete items by dragging them into the Recycle
Bin. If you press SHIFT while dragging, the item is deleted
from your computer without being stored in the Recycle Bin.

Restoring an item in the Recycle Bin returns that item to its
original location.

To retrieve several items at once, hold down CTRL, and then
click each item that you want to retrieve. When you have
finished selecting the items that you want to retrieve, on the
File menu, click Restore.

If you restore a file that was originally located in a deleted folder,
the folder is recreated in its original location, and then the file
is restored in that folder.

The following items are not stored in the Recycle Bin and cannot
be restored:

o Items deleted from network locations.
o Items deleted from removable media (such as 3.5-inch disks).

o Itemsthose are larger than the storage capacity of the Recycle
Bin.

6. Network Neighborhood: In Windows, Network Neighborhood
has been renamed My Network Places and is located on the
desktop. My Network Places provides a view of all the shared
computers, files and folders, printers, and other resources on the
Network to which your computer is connected. For you can open
My Network Places by double-clicking My Network Places on the
desktop.

My Network Places displays all of the shared computers, printers,
and other resources on the network to which your computer is
connected. You can use the Add Network Place wizard to create
shortcuts to network, Web, and FTP servers. Computers Near Me
enable you to narrow your search to computers in the same
workgroup. To open My Network Places, double-click My Network
Places on the desktop.

To connect to a NetWare volume by using My Network Places
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1.  On the desktop, double-click My Network Places.

N

Do one of the following:

Double-click NetWare or Compatible Network.

O

Double-click Entire Network, view the entire contents, and then
double-click NetWare or Compatible Network.

O

3. Double-click a tree or volume to see the contents. You
can then double-click those contents to see other computers
or volumes.

4. Do one of the following:

o When you find the volume or folder that you want to access,
double-click the volume or folder to expand it.

o Tomap alocal drive to the volume or folder, click the volume or
folder, and on the Tools menu, click Map Network Drive.

When you map a network drive, you are connected by default
under the user name and password you used to log on. To
connect under a different user name, follow the instructions in
the Map Network Drive wizard.

To view or connect to NetWare resources, you must first install
Client Service for NetWare or Gateway Service for NetWare,
and the NWLink IPX/SPX/Net BIOS Compatible Transport
Protocol.

3.2 Practices on Starting a Program like Start Menu, Programs
Menu, Documents Menu, Find and Help Menu

1. Start Menu: To start a program each time you start Windows

1. Click Start, point to Settings, and then click Taskbar
& Start Menu.

2. Click the Advanced tab, and then click Advanced.

3. Inthe Start Menu folder, find the shortcut to the program
you want to start each time you start Windows, and drag it
to the Startup folder.
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To open the Taskbar and Start Menu Properties dialog box,
right-click an empty area on the taskbar, and then click
Properties.

To add a program shortcut to the Startup menu, drag the icon
to the Start button, the Programs menu, and then drop it in
the Startup menu.

When you click Start, you can open programs on your hard disk
by using shortcuts. Program shortcuts are usually listed in the Start
menu and submenus. The program shortcuts, folders, and
submenus listed in the Start menu come from several places:

Previous versions of Windows. If you upgraded from an
earlier version of Windows or Windows NT, your old program
groups appear as folders on the Programs menu.

Windows 2000 Setup. Windows 2000 Setup adds several
standard folders, each of which contains a group of programs.
One of these folders is called Startup; the programs within
appear on the Startup menu and run automatically when you
start your computer.

Other software setup programs. The setup programs for any
software you install may add folders to the Programs menu.

Shortcuts. You can create shortcuts to programs using the
Taskbar Properties dialog box, or you can drag icons to your
desktop or taskbar. Your administrator may also create shortcuts
for groups of users.

To start a program by using the Run command
1. Click Start, and then click Run.

2. In Open, type the path to the item you want to open, or click
Browse to locate it.

The Open box lists items you have opened recently. Click an
item in the list, and then click OK to open it.

You can open a file or folder or connect to a shared computer
by typing its path in the Open box. You can also connect to an
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Internet or intranet site; for example, to reach the Microsoft
Web site, type www.microsoft.com in the Open box.

2. Programs Menu: To start a program

Click Start, point to Programs, locate the program you want to
start, and then click it.

After you start a program, a button representing the program
appears on the taskbar. To switch from one running program
to another, click its taskbar button.

If a program doesn’t appear on the Programs menu or one of
its submenus, you can perform a search for it, create a shortcut,
and then drag the shortcut to the Start or Programs menu.

To start a program by using the Run command
1. Click Start, and then click Run.

2. In Open, type the path to the item you want to open, or click
Browse to locate it.

The Open box lists items you have opened recently. Click an
item in the list, and then click OK to open it.

You can open a file or folder or connect to a shared computer
by typing its path in the Open box. You can also connect to an
Internet or intranet site; for example, to reach the Microsoft
Web site, type www.microsoft.com in the Open box.

3. Documents Menu: Documents Menu is a desktop folder that
provides you with a convenient place to store documents, graphics,
or other files that you want to access quickly. On your desktop, it is
represented by an icon of a folder with a sheet of paper in it. When
you save a file in a program such as WordPad or Paint, or when
you save Web documents from Internet Explorer to your computer,
the file or document is automatically saved in Documents unless
you choose a different location.

Even though My Documents is the default storage location for
several programs, your documents are not stored in the same My
Documents folder as another user’s if there are multiple user
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accounts on the computer. Each user has a My Documents folder
located in the Documents and Settings\username folder.

You can change the location of your My Documents folder by right-
clicking My Documents on the desktop, and then clicking
Properties. In the My Documents Properties dialog box, type or
browse (click Find Target) for the path and folder name where
you want to store your My Documents folder.

My Documents also contains the My Pictures folder, which is the
default storage location for your pictures when you save them from
your digital camera to your computer.

4. Find: Unless you specify the /i switch, find searches for exactly
what you specify for string. For example, the find command treats
the characters “a” and “A” are different. If you were to use the /i
switch, however, find would ignore case and search for “a” and “A”
as if they were the same character.

If the string you want to search for contains quotation marks, you
must use two quotation marks for each quotation mark contained
within the string.

Using find as a filter

If you omit a file name, find acts as a filter, taking input from the
Windows standard source (usually the keyboard, a pipe, or a
redirected file) and displaying any lines that contain string.

Ordering the command

You can type parameters and switches for the find command in
any order.

Using wildcards with find

You cannot use wildcards (* and?) in file names or extensions that
you specify with the find command. To search for a string in a set
of files you specify with wildcards, you can use the find command
in a for command.

Using the /v or /n switch with the /c switch
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If you specify the /c and /v switches in the same command, find
displays a count of the lines that do not contain the specified string.
If you specify the /c and /n switches in the same command, find
ignores the /n switch.

Using find in files with carriage returns

The find command does not recognize carriage returns. When
you use find to search for text in a file that includes carriage returns,
you must limit the search string to text that can be found between
carriage returns; that is, a string that is not likely to be interrupted
by a carriage return. For example, find does not reports a match
for the string “tax file” wherever a carriage return occurs between
the word “tax” and the word “file.”

5. Help: Provides online information about Windows commands
(non-network). Specifies the name of the command about which
you want information. If you do not specify a command name, the
help command lists and briefly describes every Windows 2000
system command.

There are two ways to get online Help for a command. You can
specify the name of the command on the help command line,
or you can type the name of the command and the /? switch at
the command prompt. For example, you can type either of the
following commands to get information about the xcopy
command:

help xcopy xcopy /?

The second command is slightly faster. Click net help in the Related
Topics list for information about help with network commands.

Net Help

Provides a list of network commands and topics you can get help
with, or provides help with a specific command or topic. The
available net commands are also listed in the Commands window
of the Command Reference under N. Click Windows Command
Reference in the Related Topics list.

net help [command] net command {/help | /?}



32 MS-Windows

Parameters none

Type net help without parameters to display a list of
commands and topics for which you can get help. Is the
command you need help with. Don’t type net as part of
command. {/help | /?}-Displays the correct syntax for the
command. /help provides an alternate way to display the
help text.

3.3 Creating and Editing Text files — Deleting and Restoring
files and folders

1. Creating and Editing Text files:

On a computer running Windows 2000 Server, the folders appear
in the File Manager directory tree as subdirectories of the directory.
To create another subdirectory, you select the directory in which it
will appear and choose Create Directory from the File menu. On
a Macintosh computer, you create folders using the New Folder
command on the File menu. You view and use folders in the
Macintosh-accessible volume just as you would any other volume,
by using the View menu to see the folders organized by Name,
Date, Icon, Size, and so forth. You cannot, however, designate the
subdirectory or folder as another Macintosh-accessible volume
when the directory is already designated as a Macintosh-accessible
volume.

Edit - Starts MS-DOS Editor, which creates and changes ASCII
text files.

edit [[drive:][path] filename] [/b] [/g] [/h] [/nohi]
Parameters
[drive:][path] filename

Specifies the location and name of an ASCII text file. If the file
does not exist, MS-DOS Editor creates it. If the file exists, MS-
DOS Editor opens it and displays its contents on the screen.

/b -Displays MS-DOS Editor in black and white. You use this option
if MS-DOS Editor isn’'t displayed correctly on a monochrome
monitor.
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/g - Uses the fastest screen updating possible for a CGA monitor.

/h - Displays the maximum number of lines possible for the monitor
you are using.

/nohi - Enables you to use eight-color monitors with MS-DOS
Editor. Usually, Windows 2000 uses 16 colors.

MS-DOS Editor does not work if the file Qbasic.exe is not in
the current directory, in the search path, or in the same directory
as the file Edit.com. If you delete Qbasic.exe to save space on
your hard disk, you cannot use MS-DOS Editor.

Some monitors may not support the display of shortcut keys
by default. If your monitor does not display shortcut keys, use
the /b switch (for CGA monitors) and the /nohi switch (for
systems that do not support bold characters).

2. Deleting and Restoring files and folders:
To delete a file or folder

1. Open Windows Explorer.

2.  Click the file or folder you want to delete.
3. On the file menu, click Delete.

To open Windows Explorer, click Start, point to Programs,
point to Accessories, and then click Windows Explorer.

Deleted files remain in the Recycle Bin until you empty it unless
you press and hold down SHIFT while dragging an item to the
Recycle Bin. Then the item is deleted from your computer
without being stored in the Recycle Bin.

If you want to retrieve a file you have deleted, double-click
Recycle Bin on the desktop, right-click the file you want to
retrieve, and then click Restore.

You can also delete files or folders by right-clicking the file or
folder and then clicking Delete.

To remove items permanently when you delete them
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1. On the desktop, right-click Recycle Bin, and then click
Properties.

2.  Select the Do not move files to the Recycle Bin check
box.

Important

If the Do not move files to the Recycle Bin check box is
selected, you will not be able to recover any items that you
delete.

You can also remove an item permanently by holding down
SHIFT while dragging the item to the Recycle Bin.

If you want to use different Recycle Bin settings for different
drives, click Configure drives independently, and then click
the appropriate drive tab to change the Recycle Bin settings
for that drive.

If you want to use the same Recycle Bin settings for all drives,
click Use one setting for all drives.

3.4 Copying and Moving objects — Drag and Drop feature —
using keyboard - using Standard Tool bar — Right Dragging
Method

1. Copying and Moving objects:
Copying to and from devices

You can substitute a device name for one or more occurrences of
source or for destination.

Using or omitting the /b switch when copying to a device

When destination is a device (for example, Com1 or Lptl), the /b
switch causes Windows to copy data to the device in binary mode.
In binary mode, all characters (including such special characters
as CTRL+C, CTRL+S, CTRL+Z, and carriage return) are copied
to the device as data. However, if you omit the /b switch,
Windows copies data to the device in ASCIl mode. In ASCII mode,
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such special characters as those previously listed may cause
Windows 2000 to take special action during the copying process,
as described in the following section.

Using the default destination file

If you do not specify a destination file, Windows creates a copy
with the same name, creation date, and creation time as the original
file, placing the new copy in the current directory on the current
drive. If the source file is on the current drive and in the current
directory and you do not specify a different drive or directory for
the destination file, the copy command stops and Windows 2000
displays the following error message:

File cannot be copied onto itself - 0O File(s) copied
Using the /v switch

If Windows cannot verify a write operation, it displays an error
message. Although recording errors rarely occur with the copy
command, you can use the /v switch to verify that critical data has
been correctly recorded. The /v switch also slows down the copy
command, because Windows must check each sector recorded
on the disk.

Using the /a and /b switches

The effect of an /a or /b switch depends upon its position on the
command line. When the /a or /b switch follows the source file
name, copy performs as shown in the following list:

/a Treats the file as an ASCII (text) file and copies data that precedes
the first end-of-file character. Copy does not copy the first end-of-
file character or the remainder of the file.

/b Copies the entire file, including any end-of-file character.

When the /a or /b switch follows the destination file name, copy
performs as shown in the following list:

/a Adds an end-of-file character as the last character of the file.

/b Does not add an end-of-file character.
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Combining files with the copy command

If you specify more than one source, separating entries with a plus
sign (+),copy combines the files, creating a single file. If you use
wildcard characters (* or ?) in source but specify a single file name
in destination, copy combines all files matching the file name in
source and creates a single file with the file name specified in
destination.

In either case, copy assumes the combined files are ASCII files
unless you specify the /b switch.

Copy files in subdirectories

To copy all of a directory’s files and subdirectories, you should use
the xcopy command.

Copying zero-length files

Copy does not copy files that are 0 bytes long. Use xcopy to copy
these files.

Changing the time and date of a file

If you want to assign the current time and date to a file without
modifying the file, use a command in the following format. The
commas indicate the omission of the destination parameter.

Copy /b source+,

Move — Moves one or more files from one directory to the specified
directory.

Move [ly | I-y] [source] [target]
Parameters

ly - Suppresses prompting to confirm you want to overwrite an
existing destination file.

The /y switch may be preset in the COPYCMD environment
variable. This may be overridden with /-y on the command line.
The default is to prompt on overwrites unless the copy command
IS being executed from within a batch script.

/-y - Causes prompting to confirm you want to overwrite an existing
destination file.
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Source- Specifies the path and name of the file or files to move. If
you want to move or rename a directory, source should be the
current directory path and name.

Target- Specifies the path and name to move files to. If you want
to move or rename a directory, target should be the desired directory
path and name.

2. Drag and Drop feature:
To move files by dragging:

1. Open Windows Explorer. Find the file or folder you want to
move.

3. Make sure the destination for the file or folder you want to
move is visible.

4.  Drag the file or folder to the destination.

To open Windows Explorer, click Start, point to Programs,
point to Accessories, and then click Windows Explorer.

If you drag using the right mouse button, a menu appears with
the commands Move Here, Copy Here, Create Shortcut(s)
Here, and Cancel. Click the command you want.

To copy the item instead of moving it, press and hold down
CTRL while dragging.

If you drag an item to another disk, it is copied, not moved. To
move the item, press and hold down SHIFT while dragging.

To drag by using MouseKeys

To move the pointer over the object you want to move or over
the area you want to move to, press the arrow keys on your
numeric keypad.

To hold down the mouse button, press the INSERT key on
your numeric keypad.

To release the mouse button, press the DELETE key on your
numeric keypad. Make sure MouseKeys is turned on.

To change accessibility settings from Control Panel, click Start,
point to Settings, click Control Panel, and then double-click
Accessibility Options.

If MouseKeys doesn't function, press NUM LOCK, and then
try MouseKeys again.
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To specify whether NUM LOCK must be on or off for MouseKeys
to function, on the Mouse tab, click Settings, and then for Use
MouseKeys when NumLock is, click On or Off.

To change the pointer speed and acceleration when using
MouseKeys, on the Mouse tab, click Settings, and then move
the sliders to adjust the pointer speed and acceleration.

To temporarily increase or decrease the pointer speed, on the
Mouse tab, click Settings, and then select the Hold down
Ctrl to speed up and Shift to slow down check box.

3.5 Printing from Windows

To Print a document

1.
2.

Open the document you want to print.
On the File menu of the program you are using, click Print.

In the Print dialog box you can see the number of
documents waiting to print on any printer installed on your
computer by right-clicking the printer in Select Printer
and then clicking Open.

If you are logged on to a Windows 2000 domain running Active
Directory, you can click Find Printer to search for a printer on
the network with the capabilities you want, such as high-speed
or color printing. For more information on searching for a printer
see Related Topics.

To store a document as a file rather than sending it to the printer,
click the Print to file check box in the Print dialog box.

For easy access to your printer, you can create a shortcut to it
on the desktop. You can double-click the shortcut to open the
print queue and view the documents waiting to print. For more
information on how to create a shortcut, see Related Topics.

You can print a document without opening it by dragging its
icon to a printer in the Printers folder or to a shortcut on your
desktop.

While a document is printing, a printer icon appears next to the
clock in the status area on the taskbar. When this icon
disappears, it means that your document has finished printing.
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4.1 Creating, Opening and Modifying Documents

MS-WORD is an advanced word processing product by
Microsoft for IBM-AT and compatibles. It can integrate information
from non-Word programs like spreadsheets, databases, graphic
sources, etc., and ensures that MS-WORD documents are
automatically updated when those outside information sources
change.

To start word, click on the start button and place the pointer
on the Programs item. A sub menu of the programs item is
displayed. In this menu click on the item which shows Microsoft
Word. The word document window has the following basic
components:

1. Title bar 2. Tools bar 3. Menu bar 4. Ruler bar
5. Status bar 6. Scroll bar 7.Work space

1. Title bar: It will display the name of the currently active Word
document.

2. Tools bar: Word has two most commonly used tool bars-
Formatting tool bar and Standard tool bar. These are displayed
just below the title bar.

3. Ruler bar: The ruler bar allows you to format the vertical
alignment of text in a document. It can also be used to set tab
stops on a line.

4.  Status bar: It displays information about the active document
or the task on which you are currently working. This includes the
page number that you are on, the column and line number on
which you have positioned the cursor and so on.

5.  Scroll bar: It helps you scroll the contents of a document.
You can do so by moving the elevator along the scroll bar, or by
clicking on the buttons with the arrows marked on them, to move
up and down a page.

6. Workspace: It is the area in the document where you enter
the text of your document.
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Select the option File from the Menu bar. A drop down menu
will be displayed. From the menu, choose the option new. The
New dialog box will be displayed. Word will prompt you to choose
a document template. There are various types of templates
available, choose Normal for general purpose and click on OK. A
new document window will be displayed for you to enter your text.

Now type the text in the document. At the end of a line, the
text will automatically word-wrap to the next line in case it does not
fit on the current line. It is not necessary to press the <Enter> key.
When the end of a paragraph is reached, the <Enter> key has to
be pressed to insert a blank line before the next paragraph.

When you enter your text, you are quite likely to make
mistakes. Correction of these mistakes is called editing. Editing
text is an essential feature of a word processing package. The
following keys are used to move around in a document:

Leftarrow () —Left one position Rightarrow () — Right one
position

Up arrow( ) — Line above Down arrow () — Line
below

<CtrI> Ctrl and left arrow Previous word

<CtrI> Ctrl and right arrow Next word

<Home> Home Beginning of a line

<End> End End of line

To insert characters, position the cursor at the point where
the characters have to be inserted and type them. The button OVR
on the status bar will appear dim when word is in the insert mode
and highlighted when it is in the overwrite mode. The insert key
can be used to toggle the mode of operation. In the insert mode
you can insert as many characters as you desire. Word
automatically reformats the paragraph and moves words that do
not fit on the current line to the next line or the current page to the
next page as the case may be.

By pressing either the <Backspace> or the <Del> key, a
character is removed from the working copy. The <Del> key
removes a character from the current cursor and moves the cursor
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one position left. Lines can be inserted by pressing the <Enter>
key when the cursor is either at the beginning or the end of the
line.

When you key in your document, the document is stored in
the internal memory of the machine. In order to preserve the
document for future use, you must save it on the disk. To do so,

Click on the option File on the Menu bar. The same drop down
menu that was displayed while creating the document will be
displayed.

Select the option Save from the drop down menu. The Save
As dialog box will be displayed.

Key in the name of the new file in the File Name text box and
click on OK. By default the new document will be saved as a
word document, with an extension DOC.

To open an existing document, select the option Open from
the File drop-down menu. The Open dialog box will be displayed.
Select the directory where the document is stored from the list of
directories displayed. Enter the file name to be retrieved or click
on the name of the file in the Files list and click on OK to complete
the process. The document will be displayed.

Note: The students are advised to practice on how to create, edit
and save files in MS-WORD. Also practice different options present
in drop-down menus of Menu bar.
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4.2 Practice on changing page layout, setting of tab stops,
Text block Operations

1. Changing page layout: After having created a draft copy of a
document you may find the format of the page is not what you
want it to be. Margins, left, right, top and bottom may have to be
altered, to suit your requirements. Margins refer to the logical
boundary of the text on your document. To change margins:

Select the option Page Setup from the file menu. The Page
Setup dialog box will be displayed.

Click on the tag Margins. Enter the size (normally in inches) of
the Top, Bottom, Left and Right margins in the text boxes.

To take printout of the Document you need to change the page-
size for this select Paper Size, enter the width and height of
the page in the boxes. Alternately, you can click on Paper Size
to get a list of standard paper sizes from which you can choose.

Orientation refers to the manner in which a document is printed.
There are two types: Portrait and Landscape. In Portrait
orientation, the page in longer than it is wide. In Landscape
orientation, the page is wider than it is long.

2. Setting of Tab Stops: When you are creating or editing a
document, you can set the distance that the cursor must skip on
each depression of the tab key. This allows easy movement of the
cursor while typing large volumes of text. This is particularly useful,
when creating documents that contain columns of text. To create
a Tab Stop:

Click on the Ruler bar at the position where you want a tab
stop. An L shaped mark will be displayed on the ruler indicating
the position of the Tab Stop.

To remove a tab stop, position the mouse pointer on the tab on
the ruler bar and double click on it. The Tabs dialog box will be
displayed.

Click on Clear and then on OK to remove the tab. If all the tabs
are to be removed, click on Clear All before clicking on OK.
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3. Editing Text-Block Operations: Consider a situation where
you have typed a large document. You realize that a paragraph
has been typed twice. To delete this paragraph, you can press the
<Del> until the text is deleted. This is a very tedious process. A
better option would be to mark the entire block and then press
<Del> button on the keyboard to delete the text.

Editing a group of words, a paragraph or a group of
paragraphs in a document involves block operations. Blocks are
of two kinds: 1. Text Blocks 2. Rectangular Blocks

1. Text Blocks: A text block consists of lines, sentences or
paragraphs. They extend across a page or pages, although they
need not begin or end at a margin. To mark the text block:

Position the cursor at the beginning of block to be marked.
Hold down the left mouse button and drag the mouse across
the text. The selected text will be highlighted.

2.Rectangular Blocks: Arectangular block as the name suggests,
is a rectangular block of characters, across lines or pages. Notice
that the highlighted block does not cover entire lines of text. To
mark a rectangular box of text:

Hold down the <alt> key and drag the mouse across the text,
with the left button held down.

Cutting and pasting: Very often, after creating a document, we
find it necessary to rearrange the text, by moving-paragraphs from
one location to another. This is referred to as a cut and paste
operation.

To cut text:

Mark the text as described earlier.

Move the cursor pointer such that it points at the highlighted
text, and the right mouse button. The short cut menu will be
displayed.

Select Cut from the options provided. The text will be removed
and copied to the Clipboard.
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To paste the cut text:

Position the cursor at the location where the text is to be pasted,
and right click the mouse. The Short Cut menu will be displayed.

Select Paste from the options available and the text will be
copied from the Clipboard to the current cursor position.

Copying and Pasting: Itis possible to make a copy of a block of
text in another part of the same document, or for that matter, in a
different document altogether. To do this

Mark the text to be copied.

Right click on the highlighted text and choose Copy from the
Short Cut menu that is displayed.

Move the cursor to the location where you want to paste the
text. In case the location is in a different file, the file will have to
be opened before doing the pasting operation.

Right click and paste the text by selecting the option Paste
from the short cut menu.

Alignment of Text: It refers to the position of the text relative to
the margins. Text can be centered, right aligned, left aligned or
justified. To right align a paragraph, position the cursor on any one
line within the paragraph and click on the Align Right button or, the
Formatting toolbar. To left align a paragraph, is the default mode,
position the cursor on any line within the paragraph and click on
the Align Left button on the Formatting toolbar. To center a line of
text, position the cursor on the line and click on the button Center
on the Formatting tool bar. This option is generally used for
centering heading text and not for complete paragraphs.

Changing Text Attributes: This determines the way in which text
is displayed on the screen. In a professional document, certain
words need to be emphasized more than the rest of the text. The
words can be underlined, highlighted or italicized.

To make the text bold:
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Mark the text using the mouse.

Click on the bold button on the Formatting toolbar.
To underline the text:

Mark the text using the mouse.

Click on the Underline button on the Formatting toolbar.
To italicize the text:

Mark the text using the mouse.

Click on the Italic button on the Formatting toolbar.

Note: Students are advised to make use of these features described
above, and can perform a fair amount of formatting the document.
This will make your documents a little more presentable than, when
you created a document for the first time.

Exercise: Create a file with name SAMPLE.DOC type some text
and adjust the page layout as follows:

Top=2 Bottom=2 Left=0.75 Right=1.25
From Edge Header=0.9 Footer=0.9

Orientation should be Landscape

All headings should be in bold

All information in brackets should be italicized

Mark the entire text and view it with different alignment settings
centered, right aligned, left aligned and justified

4.3 Practice on Formatting Text — Customizing paragraph
formats — changing font styles and size — working with tables
and printing documents

1. Customizing Paragraph Formats:

To format the texts use the paragraph format option of MS-
WORD. For this,

Select the option Format from the Menu bar. A drop down menu
will be displayed.
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Select Paragraph from the menu. The paragraph dialog box
will be displayed. Enter the settings of your choice and click on
OK to complete the process.

Indentation determines the position of text relative to the left
and right margins. To indent text with the left and right margins,
you:

Enter the indent distance in inches in the Indentation left and
Indentation Right text boxes.

In addition, you can also specify the type of indentation you
want for the first line of each paragraph. The option special
gives you a choice of three sub options:

None, which aligns first line of the selected paragraph with the
left indent.

First Line, which indents the first line of the paragraph by the
amount you specify in the By box.

Hanging, which shifts lines after the first line of the selected
paragraph to the right by the amount you specify in the By box.

Setting inter-paragraph spacing: The option Spacing determines
the space between lines and between paragraphs. You can specify
the amount of space above the first line of a paragraph in the
Before text box and the amount of space below the last line of a
paragraph in the After text box.

Setting inter-line spacing: Line spacing determines the amount of
vertical space between lines of text within a paragraph. The options
available with Line Spacing are:

Single, which sets the line spacing for each line to that of the
largest font in the line.

1.5 lines, which sets the line spacing to one-and-a-half times
that of single line spacing.

Double, which sets the line spacing to twice that of the single
line.

Exactly, which sets a fixed line spacing.
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At least, which sets a minimum line spacing that Word can
adjust to accommodate larger sized fonts.

Multiple, which allows the line spacing to be decreased or
increased by percentage.

2. Changing Font Styles and Size: Font refers to the manner
or style in which text is displayed in your document. You can change
the font of a paragraph or a block of text. To change text font:

Position the cursors on any line in the paragraph, or mark the
text whose font is to be changed.

Click on the option Format on the Menu bar and select Font.
The Font dialog box will be displayed.

Select the font you require from the Font list, font style from
the Font Style list and character size from the Size list. You will
see a preview of what your text will look like in the Preview
Window.

Click on OK to complete the task. The font will be applied to
your text.

3. Working with tables and printing documents

Atable is an arrangement of text in the form of columns and
rows. Tables are often used to compare two sets of data. To create
a table:

Click on the option Table on the Menu bar.
Select the option Insert Table.

Specify the number of rows and columns; enter the column
width in the Column Width text box.

Find and Replace Option: The find and replace option of Word is
a convenient way of searching for a word in a document and
replacing with some other text. It can be used in situations where
an error has been committed consistently in a document and has
to be corrected, to replace every occurrence of Word. To do this:

Click on Edit on the Menu bar and select the option Replace.
The Replace dialog box will be displayed.
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Enter the text to be searched for in the Find What text box and
the text to replace it with in the Replace With text box.

Click on Replace to replace each occurrence, one by one or
Replace ALL to replace every occurrence with the new contents.
Click on Find Next to skip to the next occurrence of the search
word.

Printing a Document: Like all Word Processors, Word allows
you to make a copy of a document on paper. Before printing a
document, it is necessary to setup the printer. This is because,
printers are of different kinds and therefore, you have to tell Word
what kind of printer you are using, before you actually print your
document. If the printer has not been setup properly, the document
may not be printed as expected. For this,

Click on the option File on the Menu bar and select the option
Print. The Print dialog box will be displayed. Alternatively you
can use the Short Cut <Ctrl><P>

Click on the button Printer, to set up the printer, if you have not
done so already. The Print Setup dialog box will be displayed.

From the list of printers available, select the printer, which
matches your printer’s configuration.

Click on Set Default Printer, to make this your default printer
set up. The Cancel button will change to a Close button.

Click on Close. The Print dialog box will be displayed once
again.

Enter the number of copies required in the Copies text box.

Click on the option ALL to print the entire document, Current to
print the current page or enter the page numbers to be printed
in the Pages text box. Click on OK to start printing.

Exercise: Create a document using the following text and Word
features: The text in main document should be in the font Arial.
The font size of the body text should be 12 and that of the title
should be 16. The comparison data should be in a table.
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The Printer

The output on the VDU cannot be stored for later reference.
For a permanent output, you would require a printer, which is also
a common output device. Using a printer you can obtain output on
paper. Another output device that produces output on paper is the
Plotter.

Printers are capable of printing at very high speeds. Two
printers commonly used with the PC are the dot-matrix printer and
the laser printer.

A comparison between these two printers is given below.

Dot-matrix printer Laser printer
Prints characters in Prints fully formed
The form of dots characters

Speed: 150-240 Speed:8 pages per
Characters per second minute or more

Inexpensive Expensive
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5.1 Working with Excel Work sheet-Formatting-Entering
Formulae-

Inserting Rows and Columns
1. Working with Excel Work Sheet:

A spreadsheet is a generic term for a software package
that simulates a paper worksheet often used by people in
management. It supports fast calculations, what-if analysis,
charts, and automatic recalculation and has other powerful
features. The Excel package is very similar in function to
any other spreadsheet package. One aspect in which the
Excel worksheet is different in that it can hold not only data
and formulae, but also graphic objects like pictures and
iImages. Excel uses data from the worksheet and displays it
graphically along with the worksheet. Excel also allows you
to define macro, which you can use to combine a series of
actions to automate your work. These macros are stored in
macro sheets. In Excel, you can set up a group of cells as a
database. You can find, update and add records. You can
extract records that match any criteria that you specify. Some
features of Excel:

The intersection of a row and a column is called a cell. Excel
has 16384 rows and 256 columns.

Each cell has a unique address and is referred to by a row
number and column letter combination. An example of a cell
address is G8, where G is the column letter and 8 is the row
number.

Operations are usually performed on range of cells. A cell range
is a group of contiguous cells, for example G4:G7. Excel uses
a : (colon) to denote a range of cells.

Users have to enter the necessary data in cells. The data can
be labels, values or formulae.
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The currently active cell is denoted by the position of the cell
pointer. It is possible to enter or modify the contents of only the
current active cell.

You can make a cell active by pointing and clicking the mouse
or by using the cursor movement keys on the keyboard.

Excel provides the user with Toolbars. This feature of Excel
allows you to carry out common commands quickly by clicking
on the appropriate button.

The software does calculations once the type of computation
has been specified and the result is displayed in the marked
cell.

Scroll bars can be used to move up and down or left and right
on the screen. They are displayed at the bottom of the
worksheet.

The Principal activities of a spread sheet program are:

1. Entering 2. Editing
Data Data

e
/

3. Storing 4.Printing
Work sheets Work Sheets

Fig. 5.1.1
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Fig 5.1.2 Excel worksheet
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2. Formatting a Worksheet

The appearance of data in a worksheet can be enhanced.
This is called formatting. By default, when labels are entered they
are left justified i.e. they appear on the left of the cell. Labels can
also be right justified or centered across a cell. You can display
data by making it Bold, italicized, or underlined.

Numeric data can also be formatted. Values can be displayed
with commas, the percent symbol and currency signs. It is important
to note that though the displayed values contain alphanumeric
characters like the comma, the dollar sign or the percent symbol,
internally they are stored in a purely numeric form in the memory.

Another feature that helps in formatting cells is the shortcut
menu. The most commonly used commands for a selection are
placed in a single menu. All you have to do is select the cell or
range of cells that you want to work on and click the right mouse
button. A shortcut menu is displayed and you can choose what
you want from this menu.

To format a cell entry:

Select the cell to be formatted and click the right mouse button
to open the shortcut menu
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Select Format Cells from the Shortcut menu.

Choose the type of formatting (Currency, percentage, number)
to be done from the Category list in the Format Cell Dialog
box.

Select the specified format to be applied from the formats
available in the Format Codes list and click on OK t complete
the process.

3. Entering Formulae

A formula defines a relationship between cells. It specifies
Excel what operations are to be performed on the values of the
cells it relates. It usually contains arithmetic values, expressions,
cell addresses or ranges. It can be created using arithmetic
operators like +, -, *, /. A formula in Excel is preceded by the =
sign. As a formula is being entered, it gets displayed on the Formula
bar. It is just above the worksheet and also displays information
about the active cell.

The Formula bar displays two other buttons — the Enter and
the Cancel buttons. They perform the same functions as the
<Enter> and the <Esc> keys. These buttons appear only when
you are entering data into a cell. Formulae are entered in the cells
by simply typing them. Excel offers Function Wizard, which is
available on the standard toolbar. Let us look at some of the
statistical functions that Excel offers,

The function, =SUM (<cell range>)

Adds the values of cells listed in the cell range. For example, =SUM
(G6:G9) would compute the total of the values stored in the range
of cells G6 to G9.

To compute the average of a range of cells, the function

=AVERAGE (<cell range>) can be used. For this you do the
following:

Mark a cell as active cell by clicking on it.
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Click on the Function Wizard, which is on the Standard tool
bar.

From the Function Category select the option Statistical.

A list of statistical functions available will be displayed in the
Function Name list. Select the option AVERAGE and click on
Next.

Another dialog box will be displayed, enter the range of cells
on which the AVERAGE function is to be applied in the Text
box, number 1. If the average function is to be applied to more
range of cells, you specify the ranges in the Text boxes, number
2, number 3 and so on.

Click on Finish to complete the operation.

4. Inserting Rows and Columns

Sometimes, after creating a worksheet, you find that a new
set of information has to be added either a row or a column of
data. To insert a new row and a new column, you do the following:

Position the Active Cell pointer on the row where a new row is
to be inserted.

Click on Insert in the Menu bar and select Rows. Now a new
row will be inserted before the row where the cell pointer was
positioned.

Position the Active Cell pointer on the column where a new
column is to be inserted.

Click on Insert in the Menu bar and select columns. Now a new
column will be inserted on the left side where the cell pointer
was positioned.

A worksheet created needs to be saved on to the disk for
later use. For this click on File option in the Menu bar, click on
Save. Excel will prompt you for a file name. You type the file name
and click on OK. Excel worksheets have a default extension name
of XLS.

To print your worksheet, you can either use the Print button
on the Standard toolbar, or the Print command on the File Menu.
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When you use the Print button, your worksheet is printed
immediately to the default printer using the current print options.
When you select Print command from the File Menu, a print dialog
box will be displayed. Here you can make additional choices before
printing, such as number of copies or selected pages to print.

Exercise: Vikram Business Solutions wants to analyze the trend
of sales of the following products, over the last quarter. You have
been assigned the task of creating a worksheet as shown below:

The total quantity sold for each item.

The value of each item

The average quantity sold for each item, month-wise

The total value of all the products

The average value of all the products.

Change the value of the printers sold in February to 11 and
observes the changes in Total and Average sales and the
average for month.

Vikram Business Solutions

Product Quantity sold  Price total sales
Details Jan Feb Mar perunit Qty

Computers 29 20 30 40000 79 3160000
Printers 7 3 9 12000 19 228000
UPS 10 15 30 10000 55 550000
Scanners 1 0 3 45000 4 180000

5.2 Practice on Range and Series-Moving and copying cell
contents- Creating summary reports

1. Practices on Range and Series:

Any rectangular group of cells on a worksheet is called
Range. You can refer to a range by listing the cell reference
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for the first cell in the range, followed by the last cell in the
range, for example B1:D4. You use ranges often to refer to
similar data that fails within a rectangular area on the
worksheet, such as sales data for a particular project. When
you need to refer to range in a formula, you can either identify
the range by its cell references, or you can name the range
and then use the name in the formula. Naming range can
save you time and effort. Since a name is easier to remember
than the beginning and ending cell references for a range.

To select a range of cells, you drag the cell pointer from one
corner of the range to the opposite corner. The corner where you
begin your selection is the active cell. When you select a group of
cells, a dark border is displayed around the outside of the selection
and the cells in the selection have a dark background. The above
cell within the selection has a light background.

Creating name for a range is easy. You can either select the
range or use the Name box on the Formula bar to define a name
or you can create names automatically based on row or column
headings. You can also use the Name command on the Insert
menu to define names.

Select the range.

Click in the Name box on the Formula bar, and then type the
name for the range.

For larger ranges with row or column headings, first select the
range and from the Insert Menu, you choose Name and then
choose Create.

Series — you may often need to enter a series of dates or
numbers on your worksheet. Some times you need to enter the
series January, February, March and so on. You do not have to
type the values one by one. Excel will do it for you. You enter the
first two values in the cells that will be at the beginning of the
series, then select the two cells and drag the Fill handle across
the cells that you want to fill. Excel will automatically enter the rest
of the values for you. The Fill handle is cross-shaped and appears
at the corner of the selected cells. Alternatively you can:
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Enter the first value and select the range to be filled
Choose Edit from the Menu Bar
Choose the option Fill followed by Series.

Specify the type of series. If the series is numeric, specify the
Step value by which the series value will step and the Stop
Value which will specify the last value till which series has to
be generated.

2. Moving and Copying Cell Contents

Similar to other applications on Windows, Excel lets you use
the Cut, Copy and Paste commands from the Edit menu. It also
lets you do it much faster by using the drag and drop technique.
To move the contents of cells:

Select the cells.
Click the left mouse button on the outer border of the cells.

Drag the cells to the new location and release the mouse
button.

To copy the contents of cells:

Select the cells and hold down the <Ctrl> key
Click the left mouse button on the outer border of the cells

Drag the cells to where you want to copy them, and release
the mouse button and the <Ctrl> key.

Let you may want to copy the value of a cell without copying the
formula behind the value or you may want the cell without the
value. You can do this by using the Paste Special command from
the Edit menu. For this:

Select the cell whose characteristics you want to copy
Choose Copy from the Edit menu

Select the cell where you want to copy the value



58 MS-Excel

Choose Paste Special from the Edit Menu.

From the Paste Special dialog box, choose the characteristic
you want to copy by clicking on the appropriate button; Values
in this case and click on OK.

3. Creating Summary Reports

You need a way to show as much information as is necessary
in you report. Rather than showing all of the details in your
worksheet you can determine the level of detail that will appear in
your report when you use subtotals and worksheet outlining. You
can show all of the information, show only subtotals and grand
totals or show only grand totals, depending on the purpose of your
report.

When you are preparing a report or organizing your data,
you often need to summarize the information. With Excel, you can
add subtotals automatically without manually adding space for them
or entering formulas.

For example in a worksheet containing details of employees,
you need to obtain the subtotals of their salaries grouped together
on their departments. With Microsoft Excel, you can do this by
creating subtotals for your data automatically using Subtotal
command. Before you use the Subtotals command you need to
sort your data to arrange it logically. Selecting Sort Option from
the Data Menu can do this. This will ensure, that you are adding
the subtotals at logical points in your worksheet.

Select the option Data menu from the Menu bar.
Choose Subtotals.

Select the field at the change of which the subtotals have to be
displayed.

Select the function to be applied.

Select the field to which subtotals are to be added from the
Subtotal Dialog box.
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An outline lets you display different levels of information on
a worksheet. You can collapse and expand the rows and columns
of you worksheet. If you have several rows of data followed by
subtotals, you can collapse the rows on your worksheet and display
only the rows that contain the subtotal information. All the other
rows will then be hidden.

To automatically outline your worksheet, you:

Select the option Data from the Menu bar

Choose the option Group and Outline

Select the option Auto Outline from the submenu

To outline a group of cells, first select the range of cells.
Select Data from the Menu bar.

Choose the option Group and outline.

Select the option Group from the submenu. You specify whether
you want to Outline Rows or Columns in the Dialog box that is
displayed.

Click on the Demote/Promote tool. To clear outline from the
Group and outline submenu of the Data option in the Menu
bar.

Exercise

1. Prepare a worksheet with details of Roll Number, Name, Marks1,
Marks2, and Marks3, total, average. Enter some data into the sheet.
Do the following:

Compute the total marks scored by each student. Use the copy
technique that you have learned.

Compute the average marks scored by each student. Use the
copy command to simplify the process.

Find the average marks scored by the entire class. Copy the
formula and modify it to include the desired range.
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Move the details on row 8 , down by three rows to accommodate
three new records.

Copy the names and average marks of the top three students
to another portion of the worksheet.

Outline the worksheet so that details of marks1, marks2 and
marks3 are not visible on the screen.

2. Metro TV Productions is a small firm that produces weekly
television serials. Grissoms, Robert and Sarah own it. Robert heads
the marketing division where as production department Sarah
handles. Actors, actresses and directors are employed on a contract
basis and receive salaries at the end of each month during the
period of the contract. Metro TV has people who are permanently
on the rolls of the firm. Besides marketing and support staff, film
editors, cameramen and the like are permanent employees. For
each script, scriptwriters receive payment in full on delivery.

The firm has office on rent basis and the other expenses
that the firm incurs are on account of film, tapes, stationary and
advertising. You need to prepare a worksheet that holds the data
on the monthly expenses of the firm for the six-month period.

April May June July Aug Sept

Salaries

Contract 25000 55000 40500 50000 60000 70000
Payment 30000 30000 30000 30000 30000 30000
Rent

Studio 32000 56000 54780 67980 87000 89000
Cameras 6789 8987 9000 12000 11000 9000

Lights 7855 7000 5000 5555 4560 4000
Props 8960 6000 10924 15000 9000 10000
Miscellaneous

Tapes 7885 6000 7800 7500 9800 9700
Film 8950 8495 9980 11029 11098 24090
Stationary 1200 1490 1340 1600 980 900

Advertising 10000 15000 17000 10000 16000 25000
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5.3 Formatting worksheets - Linking Work Sheets — Working
with Graphic Data

1. Formatting worksheets

Let your work involves long hours of starting at a worksheet
on the monitor, then it may be a good idea to make it as pleasing
to the eye as possible. Excel makes this possible by allowing you
to format your worksheet to suit your needs and tastes. Excel lets
you change the appearance of the text in your worksheet. It handles
fonts as most other Windows applications do. The term Font refers
to the style of the next. You can change the font, size, attributes
and color. To change font:

Select the cells whose font has to be changed
Right-click on the selected range

Choose the Format Cells option from the Shortcut menu and
click on the tag Font.

In the Font Dialog box, you select Font, size, Font-style, Effects
and Color as you desire.

You can reduce your formatting work by using the AutoFormat
utility. AutoFormat allows you to apply a standard format to a group
of cells instantaneously. Excel provides several standard formats
that you can choose from. To apply a standard format:

Select the cells you want to format
Choose the Auto Format option from the Format menu

Select a format from the Table Format list and click on OK.

The range of cells will now have the selected format. In the
sample box you can see a sample of what the format looks like.
By default, all the formats are applied. If you want to apply only
some formats, you click the Options button and disable the ones
you do not want.
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Fig 5.3.1

b

2. Linking worksheets

In Excel, you can link cells in one worksheet to cells in another.
The first worksheet is referred to as Source worksheet and the
second worksheet is referred to as Destination worksheet. Linking
saves you the trouble of updating changes to worksheets that share
values. To place a linked copy of cells from one worksheet into
another:

Ensure that both the source and destination worksheets are
open.

Select the cells that you want to link, in the source worksheet.

Right-click on the selected cells and choose Copy from the
Shortcut menu. Activate the destination worksheet.

Select the cell that will be the upper left corner of the target
range of cells. Choose Paste Special from the Edit menu.

Click on Paste Link to complete the process.

Now the destination worksheet contains the copy of the linked
cells from the source worksheet. Any change made in the source
worksheet will be reflected in the destination worksheet as well.
To ensure that your worksheets link successfully, you follow these
simple rules:

Save the source worksheet before linking it to another.
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Rename linked worksheets using the Save As option from the
File menu. Using the File Manager or a DOS command may
disconnect the links.

Store linked worksheets in the same directory.

Exercise: Consider a company Varsha Business Machines is a
company that offers Computer hardware and Software products.
It has three divisions: the Micros division, the Software division
and the Power Products division. The Micros division deals in IBM
PC products. The software division makes customized and
packaged Software. The power products division deals in UPS
and Stabilizer products. The manager of each of the three divisions
reports to the General Manager Sales (GM).

At a meeting with the GM, the three Divisional Managers set
their targets for the year. The GM’s office monitors the sales made
by the divisions. Every quarter, the GM compares the actual sales
made with the targets. The GM maintains a worksheet called
MONITOR.XLS that has the quarter-wise targets for each division.

Every month, each Divisional Manager sends the figures of
actual sales made. The GM maintains these figures in another
worksheet called SALES.XSL. The GM has linked the two
worksheets, SALES.XSL and MONITOR.XSL. As each month’s
details come in they are entered in SALES.XSL. As soon as the
month’s data in entered in the file, the data is automatically added
to the actual sales in the worksheet MONITOR.XSL. Therefore all
changes made in one worksheet are immediately reflected in the
other one.

Prepare two work sheets SALES.XSL and MONTOR.XSL.
Enter some data based on the above description. Link them and
check that all changes made in one worksheet are immediately
reflected in the other.

3. Working with Graphic Data

Very often, your worksheet must do more than just store data.
Sometimes, you need to use the data for presentations. The best
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way to do this is to use charts. A picture is worth a thousand words
or in this case, worth more than a thousand rows and columns of
data. Excel charts are simple to create. It provides the ChartWizard
tool that simplifies creation of charts. The chart and worksheet
data are linked, so you need not worry about changing the chart if
you have changed the data.

The following types of business graphics shall be included in
the Excel sheet: Line, Pie, Scatter, Bar and Area. Each type of
chart is available in several formats. Charts are embedded in the
worksheet and can be viewed along with the data. When you save
the worksheet, the chart is saved with it. When you print the
worksheet, the chart is printed with it.

To create a chart:

Select the data you want to put into the chart
Click on the ChartWizard tool.

Place the cursor on the worksheet at the position where you
want the chart, and drag the mouse until the box is the size
you want the chart to be.

The first Dialog box asks you to confirm the range of cells you
have selected. If the selection is correct, you click on Next to
continue. Ifitis not, then you edit the cell reference in the range
box.

The second dialog box asks you to select the type of chart you
want. Click on the charts picture and then click on Next to
continue.

The third dialog box will show you the formats that are available
for the chart type that you have selected. Click on the picture
of the chart format that you want and click on Next.

In the fourth dialog box specify how the data must be plotted
on the chart. You will see a preview of your chart in the Sample
chart window. Excel makes use of default settings for you. If
you want to change any of these settings, you use the following
options:

The Data Series button lets you choose whether to plot graphs
for each row or for each column.
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The Use First Column text box lets you enter the number of
columns, starting from the first column in the data range, to be
used as Labels.

The Use First Row Text box lets you enter the number of Rows,
starting from the first Row in the data range, to be used as
Labels. Titles or Legends depends on the type of chart.

In the fifth dialog box, you must specify whether the chart has
a Legend and create a title and axis labels. To add a legend,
select Yes for Add a Legend? To create a title, type the title
text in the Chart Title Text box. To create labels for the axes,
type the label text in the appropriate Axis Titles Text box.

Click on Finish to create the chart. The chart will appear on
that portion of the worksheet defined earlier.

Exercise

1. Using the worksheet created for Metro TV productions, perform
the following tasks:

Create another worksheet SUMMARY.XLS which has the totals
of Salaries, Rent and Miscellaneous expenses, month-wise.
Any change to the original worksheet should be reflected in
the new one.

Using this worksheet, create a pie chart to depict the total
expenses of Metro TV on salaries, rent and miscellaneous
expenses. Format the worksheet.

2. Create a six months (i.e. from January to June) sales data for a
company, which manufactures FMCG (Fast Moving Commercial
Goods) goods like soaps, washing powder, Toothpaste, shampoos,
hair oil. Enter some data regarding sales for the above goods in a
worksheet called SALESDET.XLS.

Create a quarterly details from the data in the worksheet
SALESDET.XSL. Name it as SALESQRT.XSL.

Link this new worksheet to SALESDET.XSL.

Create a chart that depicts the sales trends from January to
June. Embed this chart in the worksheet.

Format both the worksheets. Create different formats using
Auto Format.
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6.1 Practices on Power Point Slides

Power Point allows you to create all that is required to make
successful presentation — slides, handouts, speaker’s notes and
outlines. It also has a set of tools — wizards, templates and Auto
Layouts — which can help you create presentations quickly and
easily. The display information is very important aspect of any
presentation. Most speakers use slides for displaying information.
However, all the information is not displayed on the slide. In addition
to slides on would also require handouts to be given to the
audience, a set of notes and an outline of the presentation for the
presenter. These can be created using the slides.

Slides: These are one of the components of a presentation. These
are the individual pages of a complete presentation. Power point
slides can contain the following components:

a) Titles b) Graphs c) Draw objects d) Shapes
e) Clip Art  f) Draw Art

To make a good slide, you must understand the basic components
of a slide.

Title: A descriptive heading identifying a slide.

Subtitle: A distinctive message or brief description of the slide’s
data. It emphasizes the slides central idea.

Footnote: It indicates the source of the slide’s data.
Border: A frame for the slide. It keeps the viewers attention.

X-axis: The horizontal axis of the graph. When you are making
a graph, place groups (such as dates, time, items, places, etc)
along this axis. Atitle describing the data that is displayed should
also be mentioned along the x-axis.

Y-axis: The vertical axis of the graph. It contains numbers such
as currency or units. Atitle describing the data that is displayed
should also be mentioned.
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Series: A set of numerical data. Sometimes on graph depicts
more than one series. A label identifying a single series should
also be mentioned.

Legend title: A label that identifies a group of series.

The following are some basic types of slides that are most
often used in presentation.

Text Slides: Display non-numerical data. They can also be used
to highlight your main ideas.

Pie charts: Compare the relative proportions of the parts that
make up the whole. The circular pie represents the whole, and
the size of each sector of the pie shows its share.

Bar and Column charts: Show the value of an item as it varies
at precise intervals over a period of time. They can also be
used to compare the values of related items.

Area charts: Combine lines with patterns or colors to indicate
volume. These are used to show the cumulative total of several
series and changes in volume over a period of time.

Line charts: Depict trends over a period of time. They are also
used to show the value one variable with respect to another
variable.

Organization charts: Depict an organizations structure. They
show who is responsible of what and who reports to whom.
Thus it shows the hierarchy and formal lines of communication.

Slides with mixed content: Can contain a mixture of text, graphs
and other objects. Effective use of such slides can improve
communication and impact.

6.2 Creating a Presentation

Creating a presentation involves creating slides. Power point
offers four options to do so. The first two are the wizards
AutoContent and Pick-a-look, the other two are Template and Blank
Presentation. The Blank presentation option allows you to load
the PowerPoint default presentation or a presentation that you
have set up. To start with you will use the Blank Presentation option
to create a presentation afresh. To do so, you:
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Click on the option New from the File menu. The New
Presentation dialog box will be displayed.

Choose the option Blank Presentation. The New Slide dialog
box will be displayed.

Choose the type of format that you require from the options
provided in Choose an Auto Layout and click on OK. A new
slide with Placeholders will be displayed.

Creating a title slide: A title slide is the first slide that will be
displayed in your presentation. As mentioned earlier, a Title Slide
should be divided into three parts: the top part for the title of the
presentation, the middle for the topic and the bottom for the date
and location of the presentation. To create such a slide:

Choose the Title Slide in the Auto layout dialog box.

Click on Click to add title and key in the title. Font size and
font type can be changed by highlighting the text using the
Shortcut menu.

To add subtitle, click on Click to add sub-title and enter the
text.

After creating the title slide, you move on to creating the rest
of the Presentation. Presentation’s, especially those used for
training, normally start with a set of objectives. The objectives
should be bulleted to focus the attention of the viewer on a particular
line of text. Bullets can be indented to bring out the hierarchy of
topics on the slide. The Bulleted list option allows you to create
such a slide. To do so, you:

Invoke the creation of a new slide by clicking on the New Slide
button on the status bar at the bottom of the screen.

The Auto Layout dialog box will be displayed. Select Bulleted
List from the options available and click on OK. A new
presentation screen will be displayed.

Click on Click to add title and key in the title text in the Title
Placeholder. Alter font type and size, as you desire.
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Click on Click to add buffeted text and key in the text for the
first bullet.

Click on the Bullet On/Off button in the formatting toolbar to
undo the bullet style applied to any line of text.

Click on the Demote [Indent more] button on the formatting
tool bar to demote/indent a bullet to the next lower level.

Click on Promote [Indent less] to promote a bullet to the next
higher level.

After finishing the creation of slide save them in a PPT file.

Exercise: Create a new presentation (see Fig.6.2.1)
Select the Title Slide Auto Layout.

Add the title Global Travel and the sub-title Other Available
Services.

Add a new slide by using the Bulleted List Auto Layout.
Add the title Member Services.

Add bullets for the following items:

1. Brochures and Maps
2. Global Advantage Club
3. Accommodation Options

Add two second level bullets under “Accommodation Options™:

1. Hotels and Motels
2. Bed and Breakfast

Switch to the Outline view and move “Accommodation Options”
(with sub-bullets) to the top of the slide (the first bullet).

Save and close the file.
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1 |[__] GLOBAL TRAVELS

Other available services

2 |[] Member Services

- Accommodation options
- Hotels and Motels
- Bed and Breakfast

- Brochures and Maps

- Global Advantage Club

Fig .6.2.1
6.2 Creating a Graph

In any business presentation, facts and figures are best
represented as graph: Power Point provides you with a number of
different graphs that you can choose to display your information.
They are:

Pie charts, 2D and 3D

Bar charts, 2D and 3D
Column charts, 2D and 3D
Line charts, 2D and 3D
Area charts, 2D and 3D
Scatter diagrams

Surface charts

Doughnut charts

Radar charts

A graph can be created and viewed in different formats as a
pie, column, and so on. Legends, titles and data labels can be
added to improve readability. To create a graph:

Click on New Slide button on the status bar
Select Graph from the available options and click on OK.

Add a title by clicking on Click to add title and key in the
required title.

Double click on Double click to add graph.
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Type some sample data in the Datasheet.
Click on the Graph placeholder to return to the slide.

You can change the Graph Type, for this Double click on the
Graph placeholder.

Click on the Change Chart Type button on the Standard
toolbar.

Select the type of Chart you want by clicking on the icon.

You can group the data by using Graph placeholder. Select the
option Group from the Format menu. Select the subtype from
the options available and click on OK to complete the process.

To create a title for a graph, double click on the Graph
placeholder and select the option Titles from Insert menu.

Select the type of titles you desire by clicking on the check
boxes Chart Titles, Values [Z] Axis, Values [X] Axis, Values [Y]
AXis.

Click on OK to complete the task.

Exercise
1. Create a PowerPoint presentation.
2. Create a slide.
3. Add charts to the presentation
4. Change the bullet style in the first level
5. Also change the bullet style in the second level.



-
INTERNET

7.1 Concepts of Compute Networks — LAN, WAN

Early computers were being used as stand-alone systems in
organizations fulfilling their own requirements. With widespread
use of computers there was a realization that it would be
advantageous in many situations to use computers from remote
points. It was also felt that connecting computers together via
telecommunication lines would lead to widespread availability of
powerful computers. Very often information may have to be
transferred from one computer to another computer. For this the
computers have to be connected, such a connection of a number
of computers is known as Computer Network.

Computer networks are mainly used to connect a number of
widely dispersed computers. The main objective of such an
interconnection is to allow users of the network to access
specialized library programs, databases, etc. In India, NICNET
connects PCs located in all district headquarters with a large
computer at the National Informatics Centre in Delhi. This network
Is used to gather data for national planning. Another network in
India is the ERNET (Educational & Research Network), which is
used to connect computers at IITs and many educational and
research organizations. Another major network is the network
maintained by Indian Railways for railway reservations. Using this
network a passenger can book tickets on most major trains
anywhere in India. Indian Airlines also maintains a network for
airlines reservations.

Internet is a worldwide network of computers. Several
thousands of individual computer networks are interconnected to
form the Internet. Internet provides electronic mail, telnet (remote
login to computers), file transfer services and enormous amount
of information through various discussion groups and information
retrieval facilities.

Various methods are available for communication between
computer networks. Physical communication media are the
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physical channels through which information is transmitted between
computers in a network. Media may be classified as bounded, for
example, wires, cables and optical fibers; or unbounded, for
example, airwaves through which radio, microwave, infrared and
other signals are transmitted.

Communication satellites are launched either by rockets or
by space shuttles and parked in a geostationary orbit at 36000 km
above the equator. It acts as a microwave relay station in the sky.
Microwave signal at 6 GHz is beamed to it from a transmitter on
the earth. It is amplified and retransmitted to the earth at 4 GHz by
a system called transponder mounted on the satellite. Figure 7.1.1
shows a satellite communication link.

Hz
6G 4 GHz
/ Antenna
Computer or Sliatr'th Computer or Sliatr'th
Terminal  g—p| aton | | Terminal {—) ation
Equipment Equipment

Fig 7.1.1

Local Area Networks (LAN): A local area network is a digital
communication system capable of interconnecting a large number
of computers, terminals and other peripheral devices within a
geographical area, typically under 1 km across. LANs normally
operate within a compact area such as an office building or a
campus. The topology (different patterns of interconnections
between computers are known as network topologies) of
connection of computers in a LAN are:
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A star network
A multidrop (or bus based) network
Aring topology

The multidrop or bus topology is very popular as it is not
expensive, standardized and supported by all computer vendors.
It is called as Ethernet connection. Ethernet, developed by Xerox
Corporation, uses a coaxial cable for data transmission. Special
integrated circuit chips called controllers are used to connect
equipment to the cable, and small boxes called transceivers
transmit and receive cable data at each station. Ethernet allows
data transmission at the rate of 10 Mbps (10 million bits per second).

The ring topology is now being used for highly reliable high
speed LANs using fiber optic transmission. This allows data
transmission at the rate of 100 Mbps.

Wide Area Network (WAN): A wide area network is a digital
communication system, which interconnects different sites,
computer installations and user terminals, and may also enable
LANSs to communicate with each other. This type of communication
network may be developed to operate nationwide or worldwide. In
a WAN, the transmission medium used are normally public systems
such as telephone lines, microwave and satellite links.

The ARPANET of the Advanced Research Projects Agency
of the U.S. Department of Defense is an example of WAN. This
network connects about 40 universities and research institutions
throughout the US and Europe with about50 computers ranging in
size from mini to super computers. Another example of a WAN is
the INDONET, which is being planned by the Computer
Maintenance Corporation, India. It links three IBM/4361 systems
one each at Mumbai, Calcutta and Chennai and a PDP 11/44
system at Delhi. It is a network of large computer centers to give
nationwide access and processing facilities.

Differences between LAN & WAN:

1. A LAN is restricted to a limited coverage area of a few
kilometers, but a WAN can be used for greater distances and may
operate worldwide.
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2. The cost to transmit data in a LAN is negligible since the
transmission medium is usually owned by the user organization.
However, in case of WAN, this cost may be very high because
the transmission medium used are leased lines or public
systems such as telephone lines, microwave and satellite links.

3. In LAN, the computers, terminals and peripheral devices are
usually physically connected with cables. Whereas, in a WAN
there may not be direct physical connection between
computers.

4. Data transmission speed is much higher in LAN than in WAN.

5. Fewer data transmission errors occur in case of a LAN as
compared to WAN.

7.2 Connecting and working on Internet

The computers are interconnected through LAN or WAN to
share files, data, expensive peripherals such as fast printers, large
disks, graphics workstations, etc. Various computer networks within
a country can be interconnected. Country networks can in turn be
connected to networks in other countries. In this case one needs
interoperability. By interoperability we mean the ability of diverse
computers from different vendors and with different operating
systems to cooperate in solving computational problems. It should
be possible for users to use the network without knowing the details
of the hardware, communication method, etc. Such a worldwide
network is now available and is called the Internet. Internet is now
widely used all over the world including India. Internet provides
the following services, which are possible due to the interoperability
between networks.

Electronic Mail: This is an application in which any user on a
network can send/receive letters on his computer to/from any
person in the world who has an electronic mail address. Internet
provides a worldwide electronic mail facility. The general format of
internet email address is: <name of addressee> @<identity of
service provider>.
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File Transfer: Malil is intended for short messages. A file transfer
program is available in Internet, which allows transferring a large
file containing programs or data from a computer in any part of the
world to another. The system provides authorization of persons
allowed to copy the file. The file transfer is reliable. The rules used
in Internet for file transfer is called file transfer protocol or ftp.

Remote Login: By remote login (telnet access) we mean a user
sitting on his terminal logging on to a machine located anywhere
in the world. The user must have login account and password to
access the remote computer. This is an extremely useful facility.
For example, a company in India can develop and install software
for a company in U.S.A. and continue to maintain it from India.
The persons in two countries can communicate using email, file
transfer and remote login.

To connect to Internet, you need a computer terminal with a
modem, a phone line and an Internet Service Provider (ISP). An
ISP is a company that provides you with Internet connection service
through your phone line. You will find a wide range of ISPs that
provide different services. Then you should have an account with
Internet Service Provider. If you want to connect to Internet, you
need to install Internet explorer or Netscape Navigator in your
system. Whenever you double click on this, it will display a web
page where you type the address of (Ex: www.yahoo.com) a
company.

Then another page is displayed with the details of the
company. Like this you can search for any information. If you have
business contacts, friends in another part of the world, you can
communicate with them in seconds by e-mail. You can send and
receive messages immediately. Many web pages link to other web
pages, so it is easy to browse or surf a large amount of information
by just clicking with your mouse.

There are many search engines (Ex: www.google.com)
available on the Internet, by which we can search for any type of
information. Even if you do not know the web page address, you
can find them with the help of search engines.
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AUTOCAD

8.1 Basic Concepts on Starting up AutoCAD — Command
Window — Drop Down Menus - Toolbars

1. Basic Concepts on Starting up AutoCAD

AutoCAD is a software package which is used to design and
drawing of various engineering components. It is the drafting and
design program that has become the industry standard in
architecture, landscaping, engineering and construction.

Install AutoCAD using the default settings on your system.
Now go to Start - Programs—>AutoCAD, the Startup dialog box
will be displayed. It has four buttons in the upper-left corner. The
first two let you set up a new drawing and choose an existing
drawing to revise or update. The second two use templates and
wizards to initiate advanced setup routines. To create a new
drawing:

Click the Start from Scratch button.

Select the English (feet and inches) radio button in the
rectangular area titled Default Settings.

Click OK. Now AutoCAD Graphics window (Graphical User
Interface — GUI) will be displayed
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The AutoCAD Graphics window has title bar, the menu bar,
and two toolbars. The title bar is analogous to the title bar on any
Windows program. It contains the program name (AutoCAD) and
the title of the current drawing with its path. Below the title bar is
the menu bar, where you will see the drop-down menus, the first
two on the left and the last one on the right are Microsoft menus
(meaning that they appear on most Windows applications). Below
these menus is the Standard toolbar, which contains 30 command
buttons. Just below this toolbar is the Object Properties toolbar,
which contains three command buttons and five drop-down lists.

The blank middle section of the screen is called the drawing
area. At the bottom of the drawing area, there are three tabs: a
Model tab and two Layouts tabs. These are used for switching
between viewing modes. Below this, a Command window where
you tell the program what to do and where the program tells you
what’'s going on? Below this, a Status bar where there are eight
readout buttons that indicate various drawing modes. On the left
end of the Status bar, you will see a coordinate readout window.

2. The Command Window

Just below the drawing area is the Command Window. This
window is actually separate from the drawing area and behaves
like a Microsoft Windows window; that is you can drag it to a
different place on the screen and resize it. The command window
is where you tell the program what to do, and where the program
tells you what'’s going on. It's an important area and you will need
to learn about how it works in detail. Generally there are three
lines of text visible in the command window.

The number of lines of text in the Command window can
also be set in the Options dialog box. Click Tools = Options and
activate the Display tab. In the Window Elements area, set the
Text Lines in Command Line Window setting to 3. Then click the
Apply button and the OK button.

The command window is very important. It is here that you
will give information to AutoCAD, and where AutoCAD will prompt
you as to the next step in executing a command. It is a good practice
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to get into the habit of keeping one eye on it as you work on your
drawing. Most errors are made from not watching it often.

3. Drop-Down Menus

The menu bar, just below the title bar, consists of 11 words
and an icon. Click any of these and you will find a drop-down menu.
The icon on the left end, as the File and Edit options, are Microsoft
menus that come with all Windows compatible applications. The
menu associated with the icon contains commands to control the
appearance and position of the drawing area. Commands in the
File menu are for opening and saving new and existing drawing
files, printing, exporting files to another application, choosing basic
utility options, and exiting the application.

The Edit menu contains the Undo and Redo commands, the
Cut and Paste tools, and options for creating links between
AutoCAD files and other files. The Help menu (the last menu on
the right) works like all Windows help menus. The other eight menus
contain the most often-used AutoCAD commands. You should
practice all the commands present in menus; it will be immensely
helpful in finding the command you want. Here is a short description
of each of the other AutoCAD drop-down menus:

View: Contains tools for controlling the display of your drawing
file.

Insert: Has commands for placing drawings and images, or parts
of them, inside other drawings.

Format: It is where you will find commands for setting up the
general parameters for a new drawing.

Tools: Contains special tools for use while you are working on the
current drawing, such as those for finding how long a line is or for
running a special macro.

Draw: Holds the commands for putting new obijects (like lines or
circles) on the screen.
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Dimension: It is where you will commands for dimensioning a
drawing.

Modify: It has the commands for making changes to objects
already existing in the drawing.

Window: It has the options for displaying currently open windows
and lists currently open drawing files.

4. Toolbars

Just below the drop-down menus, a most extensive tool bar
called Standard toolbar appears. It has 30 icons, but don’t appear
as buttons until you put the pointer arrow on them, and then they
are highlighted. They are arranged into 10 logical groups. The icons
on the left half of the Standard toolbar are for commands used in
all Windows-compatible applications. The icons on the right half
of the Standard toolbar are AutoCAD commands that you will use
during your regular drawing activities for a variety of tasks. These
commands can do a number of things, including:

Link up and communicate with other AutoCAD users through
the Internet.

Change the view or orientation of the drawing on the screen.
Change the properties of an object, such as color or line type.
Borrow parts of a drawing to use in your current drawing.

Force a line you are drawing to meet another line or geometric
feature at specified points.

A few icons on the Standard toolbar have a little triangular
arrow in the lower-right corner. These arrows indicate that more
than one command can be found through these icons. These are
called toolbar flyouts.

There are 26 toolbars in all, and only four are flyouts. Any of
these flyouts can be called up as a regular toolbar, independent
from the Standard toolbar.
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Each toolbar can be customized and you can build your own
custom toolbars with only the command buttons you need for your
drawing. You can even design your own buttons for commands
that aren’t already represented by buttons on the toolbars. These
activities are for more advanced users.

You will develop your own preferences for the layout of the
AutoCAD Graphics window, including:

- Which toolbars are docked and where
- The shape of the crosshair cursor

- The background color of the drawing area

These features can be controlled from the Options dialog
box. If you share your workstation with others, you will find it
convenient to set up a profile and save it. That way, if someone
changes the organization of your Graphics window, you can quickly
restore your preferences. For this,

Click Tools—>Options, then click the Profiles Tab to make it
active.

Click the Add to List button. The Add Profile dialog box will
appeatr.

Type the name of your profile. You can also type the description.

Click Apply & Close. If you make any changes to the toolbars,
these settings will be saved as your profile.

Note: The students are advised to go through the commands in
Standard tool bar and familiar with their use. Create your own
profiles. Control and manipulate the toolbars. Place some of the
tool bars in another location on the drawing area. Try out the steps
to dock Draw and Modify toolbars on the left side. This arrangement
of the toolbars will be convenient because commands on these
four toolbars are used often.
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8.2 Practice on Basic Commands — Line command — Drawing
the Box -

1. Basic Commands: To work with the basic commands in
AutoCAD, create a new drawing area. For this choose File=>New.
In the Create New Drawing dialog box, be sure English is selected,
then click the Start from Scratch button and click OK to start a new
drawing. Be sure that the Draw and Modify toolbars have been
docked on the left side of the drawing area. If you make a mistake
and pick the wrong part of a line or the wrong line, press Esc to
end the command and then type u and press Enter key. This will
undo the effect of the last command.

a. Line Command: It draws a line between two points that you
can choose any where within the drawing area. It can be started
by selecting Line button from Draw toolbar or by choosing
Draw->Line on the menu bar, of by typing L on the command
window.

b. Drawing the Box: Select Line button from the Draw toolbar, at
the Specify First point: prompt in the Command window, type in
3,3 press Enter key, which is an absolute Cartesian coordinate
and will be the first point. Then type @6,0 press Enter key, type
@0,5 press Enter key, type @-6,0 press Enter key. Now type c
and press enter key to close. Now a box appears on the screen.

c. Erase: Used to erase the objects on the drawing area. For this
choose Modify—>Erase from Modify toolbar. The cursor changes
from the crosshair to a little square. This is called the pick box.
Place this pick box on one of the lines and click. Press enter key,
the objects are erased.

d. Offset: This is used to create lines at equidistant from the lines
already drawn. The offset command has three steps: Setting the
offset distance, Picking the object to offset, and indicating the offset
direction. Choose Modify->Offset from the toolbar or type o and
press enter key on the command window. Specify offset distance.

e. Fillet: It allows us to round off a corner formed by two lines. You
control the radius of the curve. Choose Modify->Fillet from the
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menu bar, or type f and press enter key. The default fillet radius is
0.5 units, but you want to use a radius of O units, type r press
Enter key and then type 0.

f. Extend: The Extend command is used to lengthen lines to meet
other lines or geometric figures. First, you will pick the boundary
edge or edges, and second, you will pick the lines you wish to
extend to meet those boundary edges. After selecting the boundary
edges, you must press Enter key before you begin selecting lines
to extend.

g. Trim: This is used to trim away (remove) the lines to complete
the opening. To do this, first select reference lines (cutting edges)
press Enter key. Now pick the lines between reference lines press
Enter key. The lines are trimmed away.

Exercise: Draw the following object shown in

fig 8.2.1

Follow the steps:
Draw the outside edge of the shape.

Offset the outside lines to create the inside wall.
Fillet the corners to clean them up.

Use Offset, Extend and Trim commands to create the three
openings.
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2. Drawing Units

There are five kinds of linear units in AutoCAD. Angular units
can also be one of five different types. You can select the type of
units to use, or accept the default decimal units. When you start a
new drawing using the Start from Scratch option, AutoCAD brings
up a blank drawing called Drawing1.dwg with the linear and angular
units set to decimal numbers. The units and other basic setup
parameters applied to this new drawing are based on a prototype
drawing, or drawing template, with default settings. You can choose
another template file as a prototype drawing, or you can create
you own set of prototype drawings. For this,

Start up AutoCAD by clicking Start from Scratch button in the
Startup dialog box. Select English and click OK. Make the entire
Status bar buttons except Model are clicked to the off position,
that is they will appear unpushed.

From the format menu, select Units. The Drawing Units dialog
box appears. In the Length area, Decimal is currently selected.
Similarly, in the Angle area, Decimal Degrees is the default.

In the Length area, click the arrow in the Type drop-down list
and select Architectural. These units are feet and inches. When
the linear units specification was changed from Decimal to
Architectural, the number in the Precision drop-down list on
the left changed from 0.0000 to 0’ -0 1/16 “. At this level of
precision, linear distances will be displayed to the nearest
1/16".

Select some of the other Length unit types from the list and
note the way the units appear in the Sample Output area at the
bottom of the dialog box. Then select Architectural again.

Click OK in the Drawing Units dialog box to close it. Notice the
coordinate readout in the lower-left corner of the screen. It now
reads out in feet and inches.

3. Drawing Size
The default drawing area on the screen for a new drawing is

12 to 16 units wide and 9 units high. After changing the units to
Architectural, the same drawing area is now 12 to 16 inches wide
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and 9 inches high. You can check this by moving the crosshair
cursor around on the drawing area and looking at the coordinate
readout. The drawing area can be made larger or smaller through
a process known as zooming in or out. A tool called grid will help
you to draw and to visualize the size of your drawing.

Grid: The grid is a pattern of regularly spaced dots used as an aid
to drawing. You can set the grid to be visible or invisible. The area
covered by the grid depends on a setting called drawing limits.
Use Zoom In and Zoom Out commands to vary the view of the
grid and then change the area over which the grid extends by
resetting the drawing limits. Before doing this, turn off the User
Coordinate System icon in the lower-left corner of the drawing
area.

The Drawing Limits setting records the coordinates for the
lower-left and upper-right corners of the grid. The coordinates for
the lower-left corner are 0,0 by default, and are usually left at that
setting. You only need to change the coordinates for the upper-
right corner. Drawing Limits setting controls the size of the grid,
yon need to change it.

Exercise:

1. Practice the following:

a) Set up linear and angular units for a new drawing
b) Make the grid visible and modify its coverage
c) Use the Zoom In and Zoom Out features

d) Activate the Snap mode and change the Snap and Grid
spacings.

e) Draw lines using Grid, Snap, and the coordinate readout.
f) Create a new folder on your hard drive from within AutoCAD.

g) Give a name and save your file.
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2. Prepare the following drawings:

Project 1: Building size: 125'x85’
Units: Architectural
Drawing Limits: 200, 150’
Grid/Snap Spacing: 5’

Project 1: Building size: 87'x60’
Units: Architectural
Drawing Limits: 120’, 90’
Grid/Snap Spacing: 3’

Project 1: Building size: 12’ —6"x14’-6”
Units: Architectural
Drawing Limits: 16, 20’
Grid/Snap Spacing: 6”

Summary of procedure:

1. Set the units 2. Set the drawing limits

3. Set Grid spacing to 0 and Snap spacing to the given distance.
4. Turn on Grid and Snap

5. Zoom to all 6. Draw the rectangle

8.3 Laying out the walls — Creating Doors & Windows

1. Laying out the walls

For most floor plans, the walls come first. Fig. 8.3.1 shows
the basic floor plan of a building. Draw four exterior wall lines
(rectangle with size 25’ x 16’) using line command. You will need
to create an inside wall line for the exterior walls and then make
the three new interior walls. The wall thickness will be 4” for interior
walls and 6” for exterior walls, as exterior walls have an additional
layer or two of weather protection, such as shingles or stucco.
Finally, you will need to cut five openings in these walls (interior
and exterior) for the doorways.

Create a new file and name it as CabinO1.dwg. Draw a rectangle
with size 25’ x 16'.
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On the status bar, click the Grid and Snap buttons to turn them
off. Then start of Offset command by clicking on the Modify
toolbar. You can also start the Offset command by typing o and
press Enter key.
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Fig.8.3.1: The Basic Floor Plan

Give values at the Offset distance: prompt, type 6 in the
command window. No need to enter inch sign (), but you are
required to enter the foot sign (°).

At the Select object to offset: prompt, click one of the four lines.
Click in a blank area inside. The first line is offset 6” to the
inside. Continue doing this until you have offset all four outside
wall lines to the inside at the set distance of 6”. Then press
Enter key to end the Offset command.

Clean up the corners with the Fillet command. Click
Modify->Fillet button and type r, then type O to set the Fillet
radius to zero. Click any two lines that form an inside corner.
Be sure to click the part of the lines you want to remain after
the fillet is completed. Both of the two lines will be trimmed to
make an inside corner. Continue doing this until all four corners
have been cleaned up.

Create the interior wall lines by offsetting the exterior wall lines.
Start the Offset command, at the Offset distance: prompt, type
9’4 and press Enter key. Leave no space between the foot sign
() and the 4.
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Click the inside line of the left exterior wall. Click in a blank
area to the right of the selected line. The line is offset 9’-4” to
the right. Press Enter key twice. The Offset command is now
restarted, and you can reset the offset distance. Type 4 and
press Enter key to reset the offset distance.

Click the new line that was just offset, and then click in a blank
area to the right of that line. You have created a vertical interior
wall. Press Enter key twice to stop and restart the Offset
command.

Type 6.5 and press Enter key. This sets the distance for
offsetting the next wall. Pick a point on the inside, upper exterior
wall line. Click in a blank area below the line selected. The
inside exterior wall line is offset to make a new interior wall
line. Press Enter key twice to stop and restart the Offset
command.

Type 4 and press Enter key. Click the new line and click again
below it. A second wall line is offset to make a new interior wall
line. Press Enter key to end the Offset command.

Repeat the procedure to create the bathroom wall that you
used to make the first two interior walls.

Now clean up the inside corners of the interior walls and
bathroom walls using Fillet and Trim commands. Use the Zoom
command to get a better look while cleaning.

There are five doorway openings, two are on interior and three
are on exterior walls. To make Exterior openings, start the Offset
command, then type 6 and press Enter key to set the distance.

Click one of the two interior lines, and then click in a blank area
to the right of the line that you selected. Now do the same thing
to the second wall. For this, end and restart the Offset command
by pressing Enter key twice, then type 3’ and press Enter key
to set a new offset distance and offset the new lines to the
right. Next, you will need to extend these four new lines through
the external walls to make the jamb lines.

End the Offset command then type ex on the command window.
Select the upper and lower horizontal outside, external wall
lines as boundary edges for the Extend command, and press
Enter key.
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Click the four lines to extend them. The lines are extended
through the external walls to make the jambs. End the Extend
command by pressing Enter key.

Now trim away the excess part of the jamb lines and then, the
wall lines between the jamb lines. Use Trim command for doing
this.

The two interior openings shall also be made using the same
procedure.

To make 7’ opening on the right side of the building, Offset a
wall line 12”. Offset the new line 7’. Extend both new lines
through the wall. Trim the new lines and the wall lines to
complete the opening.

2. Creating Doors

In a floor plan, a rectangle or a line for the door and an arc
showing the path of the door swing usually indicates a door.
Generally, the door’s position shown at 90°from the closed position.
Swinging doors are generally used. Follow the procedure to draw
Swinging doors:

Choose Tools->Drafting Settings, click the Object Snap tab to
activate it, be sure that all check boxes are unchecked in the
Drafting Settings dialog box. Then click OK.

At the Command: prompt, move the cursor to the Standard
toolbar and click the Zoom Window button. Pick two points to
form a window around the front doorway opening.

Choose Draw—>Rectangle; pick two points to represent opposite
corners of the rectangle. Use Object Snaps (or Osnaps) to pick
specific points on objects such as endpoints, midpoints, the
center of a circle, etc.

Move the cursor onto the Temporary Tracking Point button
on the Standard toolbar and hold down the left mouse
button. The Object Snap flyout opens and you see all the
Object Snap tools.

Holding the left mouse button down, drag the cursor down the
flyout to the Endpoint button, and release the mouse button.
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The prompt line now displays the addition of _endp of. This
activates the Endpoint Object Snap. Move the cursor near the
upper end of the left jamb line. When the cursor gets very close
to a line, a colored square appears at the nearest endpoint.

Move the cursor until the square is positioned on the upper
end of the left jamb line, and then click that point. The first
corner of the rectangle now is located at that point. Move the
cursor to the right and slightly down to see the rectangle being
formed.

When the Command window shows the Specific Other corner
point, type @3’,-1.5 and press Enter key in the command line.
The rectangle is drawn across the opening, creating a door in
a closed position.

Rotate the door around its hinge point, through an arc of 90° in
the counterclockwise direction, making it a rotation of +90. Use
Rotate command to rotate the door.

3. Creating Windows

Create a window block, and then go from room to room to
insert the block into the walls. The window in the floor plan can be
created from one block, even though they are different sizes.

Click the Layers list on the Object Properties toolbar to open
the drop-down list and select O layer.

Right-click the Osnap button on the Status bar and pick Settings
from the shortcut menu. Add check marks to Midpoint and
Perpendicular Osnaps. Then click OK.

Pick two points to be opposite corners of the zoom window.
Start the Line command, the click the Nearest Osnap button
from the Object Snap toolbar or the Osnap flyout on the
Standard toolbar. The Nearest Osnap will allow you to start a
line on one of the wall lines.

Move the cursor to the Upper wall line, a little to the left of the
center of the screen and, with the hourglass symbol still
displayed, click. A line begins.
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Move the cursor to the lower wall line. A colored perpendicular
icon will appear directly below the point you previously picked.
When it is displayed, click. The line is drawn between the wall
lines.

Using the Offset command, set offset distance to 12”. Pick the
line you just drew, and then pick a point to the right of that line.
The line is offset 12” to the right. Using Line command, draw a
line at midpoint. The three lines you have drawn will make up a
window block. They represent the two jamb lines and the glass.

Insert windows by varying the X scale factor from 2 to 6, you
will be able to create windows 2, 3’, 4’, and 6’ wide.

8.4 Drawing the Steps and Thresholds — Balcony — Laying
out the Kitchen and Bathroom

1. Drawing the Steps and Thresholds

Pape TP

Fig. 8.4.1

Figure shows a floor plan with front and back steps,
thresholds, a balcony, and kitchen and bath fixtures. Use a width
of 2’ for the front and back step, and lengths of 6’ and 5’ respectively.
The three thresholds extend 2” beyond the outside wall line and
run 3” past either jamb line.

The Front step: Open the drawing, which shows the floor plan.
Check all buttons on the status bar except Model are in the off
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position. Use zoom command to get big picture of the front step.
Start the Line command; pick a point at the lower end of the left
jamb line. Right-click the Polar button on the status bar at the
bottom of the screen, then click settings. The Settings dialog box
comes up and the Polar Tracking tab is active. In the polar Angle
Settings area, set the Increment angle to 90.00. Hold the cross-
hair cursor, a dashed line called a temporary alignment path is
displayed along with a tool tip that identifies the alignment path as
a Polar one, and a relative Polar coordinate that confirms the angle
to be 270°.

While the alignment path and tool tip are visible, type 2’ press
Enter key. A 2" vertical line is drawn. When the line command is
running and the cross hair cursor is held always from the last point,
you can enter a distance, and the line will be drawn to the desired
length in the direction of the cursor. Press Enter key to end the
Line command. Type o [press Enter key] to start the Offset
command. Type 1'6” [press Enter key] for an offset distance, and
offset this line to the left. Similarly offset a new line to the right at a
distance of 6. Erase the original line and draw a line from the
lower end points of these two new lines to represent the front edge
of the step. Use the Endpoint Osnap for each point picked. Save
the document.

The Back Step: Zoom into the back step area. Start Line command
and pick the temporary Tracking point button on the Object Snap
toolbar. Draw the side of the step using Direct Entry technique
with Polar tracking. Hold the cross hair cursor, type 5’ [press Enter
key], the front edge of the step is drawn. Select perpendicular
Osnap from the Object Snap toolbar and move the cursor to the
outside wall line, click the mouse button. The right edge of the
step is drawn and the back step is complete.

The Thresholds: These are generally used on doorway openings
where the level changes from one side of the opening to the other.
Generally, the lip of each threshold is offset 2” from the outside
wall, and each edge runs 3” past the doorjamb. You will use the
Temporary Tracking point tool with Polar Tracking and Direct Entry
to draw the thresholds. To draw the front door entry follow the
steps:
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Zoom into the opening, start Line command and click the
Temporary Tracking Point button and the Endpoint Osnap
button from the Osnap toolbar.

Click the outside endpoint of one of the jamb lines, then move
the cursor along the wall line away from the opening until the
Polar alignment path and tooltip appear.

Enter the distance that the threshold extends past the jamb
(3”), move the cross hair away from the wall line in a horizontal
or vertical direction until the Polar alignment path and tooltip
appear.

Enter the overhang distance of the threshold, move the
crosshair in a direction perpendicular to the last point of the
last segment drawn, until the Polar alignment and tooltip appear.

Enter the length of the threshold (it is the length of the opening
+ 6”). Invoke the Perpendicular Osnap and hold the crosshair
back on the wall line, then click. Press Enter key to end the
Line command.

Direct Entry of Distances is a method used to specify
distances for line segments. In this method, you position the
crosshair in such a way that the direction from the last point picked
indicates the direction for the next line segment. Then you just
type in the distance. There is no need to use either the relative
polar or relative Cartesian coordinates. This technique is primarily
used with Polar tracking to draw line segments that are oriented at
a preset angle, in this case, 90°, 180°, 270° and 0°. Direct Entry
can also be used with the Copy and Move commands to specify
displacement of selected objects being moved or copied.

2. The Balcony

The balcony is made up of two semi-circles. The easiest way
to draw an arc is to draw a circle, trim the circle to make the arc.
Follow the steps to draw Balcony:

Select Draw—>Circle; there are six options for constructing a
circle. Select the Center, Radius option. The command window
will prompt you to specify a point as the Center of the circle.
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The center of the balcony is 5" above the lower-right corner of
the outside wall line.

Establish a center in the largest room; type 5’ [press Enter key].
The circle is drawn. Click the move button on the Modify tool
bar. The cursor changes to a pick box. Select the circle and
press Enter key.

On the Object Snap toolbar or flyout, pick the Quadrant button.
Select the circle somewhere near its bottom extremity. An image
of the circle is attached to the crosshair cursor. Turn Polar
Tracking off by clicking the Polar button on the status bar.

Move the crosshair cursor around to see that the lowest point
on the circle is attached at the crosshair (Figure 8.4.2b). This
point on the circle needs to be placed at the lower-right corner
of the outside wall line.

Select the Endpoint Osnap, then pick the lower-right corner of
the cabin. The circle is positioned correctly for the balcony
(Figure 8.4.2c). Now you can use the existing wall lines to trim
the circle into a semicircle.

Start the Offset command, set the distance for 6”, and offset
the semi-circle to the inside. The balcony is complete.

= 1
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3. Laying out the kitchen and Bathroom

a) Laying out the Kitchen: Generally the kitchen will have a
stove, a refrigerator, and a Counter with a sink. The refrigerator is
set 2” away from the back wall.

Offset the right inside wall line 3’ to the left. Then offset this
new line 9'-10” to the left. Finally offset the upper inside wall
line 2’ down.

Use the Fillet command with a radius of zero to clean up the
two corners.

Select the Rectangle button on the Draw tool bar, and then
click the Temporary Tracking Point Osnap option. Use Endpoint
Osnap to select a base point at the upper end of the right side
of the counter.

Hold the cursor below the point, type 2 and press Enter key.
This starts the rectangle 2” away from the back wall, along the
side of the counter. To simplify the opposite corner of the
rectangle, type @32,-32 .

For the stove, right click the mouse. A shortcut menu pops up
next to the crosshair cursor. Click Repeat Rectangle. Now pick
the upper end of the left side of the counter as the tracking
point. Hold the cursor directly to the right of that point and type
2 [press Enter key]. Then type @27,-26 to complete the
rectangle.

Use the Trim command to trim away the front edge of the
counter at the Stove. Zoom into a closer view of the stove using
the zoom window. Offset the wall line down 2.5”. When you
pick the line, pick it somewhere to the right or left of the stove.
Then, after it is offset, trim it back to the sides of the stove.

The next step is to lay out guidelines to locate the centers of
the burners. Now draw a circle for one burner, copy it to the
other three burner locations, and then change the radius of the
left front burner.

Now draw a double sink, with one basin larger than the other.
Use Offset, Fillet and Trim commands.
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b) Laying out the Bathroom

The bathroom has three fixtures: sink, shower, and toilet.
Follow the steps to draw the Bathroom:

Zoom the bathroom view, start the Rectangle command, select
the first point, move the cursor to the upper-left inside corner
of the room click the left mouse button. The first corner of the
square is placed. For the second point, type @40, -40 [press
Enter key].

Start the Line command and move the cursor near the midpoint
of the bottom line of the square, click. Move the cursor near
the midpoint of the right side of the rectangle, Click again. Use
this line as a cutting edge and trim away the lower-right corner
of the shower rectangle. This completes the shower.

Zoom into the sink area; Offset the top inside wall line down
16”. Then use the shower wall as a cutting edge and trim back
the line.

Click the Ellipse button on the Draw toolbar, type c [press Enter
key] to select the Center option. Click the Temporary Tracking
Point Osnap button and then move the cursor near the midpoint
of the newly offset line. Establish a tracking point, move the
crosshair cursor directly above the tracking point.

When the dotted tracking path and the Track Point tooltip
appear, type 8 pr ess Enter key to locate the center of the
counter. The command window will prompt you for the location
of the ends of two perpendicular axes. You will start with the
left/right axis and enter the distance using Direct Entry and
Polar Tracking, as you did for the steps.

Hold the crosshair cursor directly to the right of the center point.
Type 7 press Enter key. Hold the crosshair cursor directly above
the center and type 5 press Enter key. The ellipse is constructed,
and the sink fixture is complete.

Zoom into the toilet area, position it in the lower-left corner of
the drawing area. Hold down the left mouse button and drag
the hand up and to the right. When the toilet area comes into
view, release the mouse button.
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Position the cursor near the top of the drawing and hold down
the left mouse button. Drag the cursor up and down, release
the mouse button. With the Rectangle command, draw the toilet
tank a few inches to the right of the wall. The offset the left wall
line 1” to the right to make a guideline.

Using Move command, position the Rectangle 1” from the left
wall and centered between the shower and lower wall. Erase
the guideline. Using the Ellipse command, place the cursor at
center point and type 6 [press Enter key]. The ellipse is
complete, and the toilet is finished.

Exercise

1. Using standard dimensions, create the following floor plan with
some basic furniture. Use the following techniques:

Use the Temporary Tracking Point tool to create and use
tracking points.

Use the Quadrant and Intersection Osnaps, set up and use
running Osnaps.

Move around the drawing area with Realtime Zoom and Pan
Use the Trim, Circle and Ellipse commands

Use guidelines to locate the center of circles for a stove top

=0 TR o
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8.5 Drawing the Roof — Develop the drawing depicting the
Reinforcement details of typical elements like column, footing,
beams and slabs

1. Drawing the Roof

To draw the Roofline (let it be a hip roof) in floor plan, the
following lines have to be drawn to represent different parts of the
roof:

Four eaves lines around the perimeter of the building,
representing the lowest edge of the roof.

One ridgeline, representing the peak of the roof

Four hip lines, connecting the end points of the eaves line to
an endpoint of the ridgeline.

Creating the Eaves: The roof is cantilevered out beyond the
exterior walls the same distance on all sides of the building; we
can generate the eaves lines by offsetting the outside wall lines.

Using Offset command, draw lines on four sides of the building
with an offset distance of 1’-6".

Using Fillet command (make sure that the radius is set to zero),
click any two lines representing adjacent sides of the building.
Click the half of the line nearest the corner that the two selected
lines will meet. The lines extend to meet each other and form a
corner.

Pick two more adjacent lines that will meet at another corner.
Start the Fillet command again and keep picking pairs of lines
until all the corners are filleted and the result is a rectangle that
represents the eaves of the roof surrounding the building, offset
1’-6” from the outside exterior walls.

Move the eaves lines onto the Roof layer, for this select the
four eaves lines, and then click the Layer Control drop-down
list on the Object Properties toolbar.

Click Roof, now the eaves lines are on the Roof layer. Press
Esc to remove the grips.
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Drawing the Hip and Ridge Lines:

Make Roof layer as the current layer, using Line command,
draw a line starting at the lower-left corner of the roof and to
the right up at an angle of approximately 45° until the Polar
tracking path with its tooltip appears. While the tracking path is
visible, type 15’ press Enter key .The first hip line is drawn.
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Fig.8.5.1: The Completed Roof

Using Line command, draw a line starting at the upper-left
corner of the roof and to the right at an angle of approximately
45° until the Polar tracking path with its tool tip appears. Type
15’ press Enter key. The second hip line is drawn.

The two hip lines need to be filleted together at their intersection,
but the bedroom door is in the way. For this, start Fillet command
(set the radius to zero) click the two diagonal lines at a place
that is close to their intersection. The lines are filleted together.
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Now copy these two diagonal lines to the right side of the roof.
Start Mirror command,; select the two diagonal lines, the press
Enter key. Click the Midpoint Osnap button and place the cursor
on the horizontal eaves line. Then move the cursor down into
the living room, keeping it directly below the point just picked,
and when the tracking line and Polar tooltip appears, click space
bar. Press enter Key when asked whether to delete old objects.
The diagonal lines from the left are mirrored to the right.

Now draw the ridgeline. Start Line command, pick two
intersections of the diagonal lines, then press Enter key. Open
the Layer Control drop-down list and turn on the Doors layer.
Then click the roof layer to close the drop-down list. This
completes the ridgeline and finishes the roof. Save this drawing.

8.6 Generating Elevations — Drawing the Front Elevation —
Putting the door, step, windows—Finishing touches—Hatching
the front Elevation

1. Generating Elevations — Drawing the Front Elevation

The front elevation is drawn using techniques similar to those
used on a traditional drafting board. You will draw the front elevation
view of the floor plan below it by dropping lines down from key
points on the floor plan and intersecting them with horizontal lines
representing the heights of the corresponding components in the
elevation. Fig. 8.6.1 shows the floor plan and the front elevation of
a building. Follow the steps to draw this:
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Check the Status bar to see that Polar, Osnap, and Model are
in the On position while the other buttons are off. Draw a
horizontal ground line across the bottom of the screen using
the Line command.

Offset the ground line 10” up to mark the height of the step.
Then offset this new line 2” up to mark the top of the threshold.

Offset the ground line 4” up to mark the top of the balcony walll
and the bottom of the windows. Offset the bottom line for the
windows 3’-6” up to mark the top of the door and windows.

Offset the top line for the windows and door 1’-6” up to mark
the soffit and roof. Offset the soffit line 6” up to the mark the
lower edge of the roof’s top surface. Offset this lower edge of
the roof’s top surface 3’ up to mark the roof’s ridge.

Now drop lines down from the points in the floor plan that
coincide with components that will be visible in the front
elevation. The front elevation will consist of the balcony, front
step, front door, and windows, the front corners of the exterior
walls, and parts of the roof.

To draw the roof in elevation, follow the steps:

Using Line command start a line from the right endpoint of the
ridgeline of the roof. Then click the Snap to None Osnap button
on the Object Snap toolbar. Draw the line straight down past
the soffit line.

Click this line to activate grips. Select the grip at its upper end
point. Press the spacebar once to access the Move command.

Type c [press Enter key] and then click the lower-right and
lower-left corners of the roof, and the left endpoint of the
ridgeline.

Type x [press Enter key] to end the Move command, then press
Esc to remove the grips. Start the Trim command and select
the two lines dropped from the ridgeline. Press Enter key.

In the elevation, pick the ridgeline to the left and right of these
dropped lines. The ridgeline is trimmed back to its correct length.
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Erase the two dropped lines that were just used as cutting
edges.

Restart the Trim command; select the two lines dropped from
the corners of the roof, the horizontal soffit line, and the line 6”
above the soffit line to be cutting edges-four lines in all. Press
Enter key.

To do the trim, click the dropped lines above and below the two
horizontal cutting edges, then click the two selected horizontal
lines to the left and right of the dropped lines — eight picks in
all. Press Enter key, the roof edge is complete.

Use the Line command to draw the two hip lines from the roof
edge to the ridgeline.

2. Putting in the Door, Step, and Windows-Finishing touches

To finish the front elevation, we need to put in the front
door, windows, front step and threshold, and a few finishing
touches.

Draw a line from the left end of the leftmost window in the front
wall of the floor plan to the ground line. Follow the same process
in steps 2 and 3 of the “Drawing the Roof in Elevation” to copy
this line to (a) each endpoint of the jamb line of each window in
the front wall, except the 2’ circular one to the right of the front
door, and (b) each edge of the front door opening.

Type x press Enter key to end the Move command, press Esc
to remove the grips. Trim all these lines. Create the step first.
For cutting edges, select the two lower horizontal lines and the
two outer vertical lines. To trim, pick each of these lines in two
places above and below, or to the left and right of the step.

To create threshold, for cutting edges, select the four lines that
form the outside edges of the threshold. To trim, pick each of
these lines (except the line that forms the top of the step) in
two places above and below, or to the left and right. Trim the
left and right edges of the door up to the top of the threshold.

Offset the ground line up to 6. Click the 2" window in the floor
plan, draw the line down through the newly offset line, draw a
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circle using the intersection of these two lines as the center
with a radius of 12”. Trim the lines passing through the circle in
four places outside of the circle.

Offset the vertical line representing the balcony’s right edge 6”
to the left. Then offset the ground line up 10”. Fillet these two
lines at their intersection with a radius of zero. Then trim the
balcony floor line back to the right wall line.

Select these two new lines, click the Properties button, click
Line type in the Properties dialog box and click Dashed. Close
the Properties dialog box and press the Esc key. The lines are
changed to dashed lines to indicate that they are hidden in the
elevation. Save this drawing.

Finishing touches: to enhance the appearance of the elevation
add detail to the windows and door, and place an extra step
leading to the front step.

3. Hatching the Front Elevation

Hatches can resemble the surfaces of various building
materials. To give texture to an AutoCAD drawing, a drafter will
hatch in areas or fill them in with a solid color. Solid fills in a drawing
can give a shaded effect when printed. In floor plan, the inside of
full-height walls are often hatched or filled to distinguish the from
the low walls. Wooden or tile floors can be hatched to a parquet or
tile pattern. In a site plan, hatches are used to distinguish between
areas with different ground covers, such as grass, gravel, or
concrete. When working with elevations, the surfaces can be
hatched to show shading and shadows. Hatches and fills are widely
used in details as a tool to aid in clear communication. To get the
best visual effect from putting hatch patterns on the front elevation,
change the background colour for the drawing area to white. For
this, choose Tools—=>Options and click the Display tab. Click the
Colors button and make the change. Create new layers for the
hatches and assign colors to them.

Open the drawing, which contains the floor plan and front
elevation only. Set up three new layers as:
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Layer Name Color
Hatch-elev-brown 42
Hatch-elev-gray Light gray (8)
Hatch-elev-black Black (White) (7)

Make the Hatch-elev-gray layer current. Click the Hatch icon
on the draw toolbar. The Boundary Hatch dialog box comes
up. Here you can choose a pattern, set up the patterns
properties, and determine the method of specifying the
boundary of the area to be hatched.

Move to the right of the Pattern drop-down list and click the
Browse button. The Hatch Pattern Palette dialog box comes
up. Of the four tabs, ANSI will be active and the ANSI31 pattern
will be highlighted.

Check the Other Predefined tab. Find the AR-RROOF pattern
and click it, then click OK. In the Boundary Hatch dialog box,
note that AR-RROOF has replaced ANSI31 in the Pattern drop-
down list. A new pattern is displayed in the Swatch preview
box. Set Scale and Angle settings to 0.00 and 6. Click the Pick
Points button.

In the elevation view, click the middle of the roof area. The
lines that form the boundary of the roof area, forming an outline
of the area to be hatched. Click OK in the Boundary Hatch
dialog box. The hatch is now placed in the roof area.

1. Create a Hatch Pattern for the roof in plan view — Make the
following changes and additions: (See Fig 8.6.3)

Make the Roof layer current and change its line type from
Dashed to Continuous. Turn off all other layers.

Put a chimney in the roof with Rectangle 2’-8” by 3’-0”, with a
circle of radius 8” inside. The circle is centered horizontally
and its lower quadrant point is set 4” up from the lower edge of
the rectangle.
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Create a new layer called Hatch-plan-roof. Assign the same
color you are using for the Roof layer. Make this new layer
current.

Now apply the AR-RSHKE pattern to each quadrant of the roof,
changing the rotation angle by 90°for each adjacent area. Use
a scale of 1.0000. When you pick the quadrant with the chimney,
pick a point in the quadrant that is outside the chimney rectangle.

Double click the hatch in the quadrant that contains the chimney.
In the Hatch Edit dialog box, click the advanced tab to make it
active. In the Island Detection area, select the Outer option,
then click OK. Now the hatch pattern does not appear in the
circle.

Move the chimney rectangle and circle to a different location in
the quadrant and see the results. See what happens if you
move the chimney lines to a different quadrant, to a location
completely off the roof.

2. Practice the following on a drawing containing floor plan and
elevation

-Create a predefined hatch pattern and apply it to a drawing
-Set up and apply user-defined hatch patterns

-Create a polar array of a line

-Use lines to indicate a curved surface

-Modify the scale of a hatch pattern

-Modify the shape of a hatch pattern

-Control the origin of a hatch pattern

8.7 Controlling text in a drawing — Setting up Text styles —
Using Single line Text - Placing Room Labels in the floor plan
— Creating a Title Block and Border

1. Setting Up Text Styles

It is necessary to use text in the drawings to include titles of
views, notes, and dimensions. Each of these may require a different
height, orientation, and style of lettering. AutoCAD offers two types
of text objects: single-line and multi-line text. A text style consists
of a combination of a style name, text font, height, width factor,
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oblique angle, and a few other static settings. These text style
properties will be specified with the help of a dialog box that comes
up when you start the Style command. Follow the steps to define
Text Style:

Open a drawing having floor plan and elevation. Create a new
layer named Text1. Assign it a color and make it current. Freeze
the Hatch-pan-floor and Hatch-plan-wall layers.

Start the Style command by typing st [press Enter key]. A Text
Style dialog box will appear. Click New, the New Text Style
dialog box comes up. There is a Style Name text box with Stylel
in it, highlighted. Enter a new style name.

Type Label [press Enter key], Label appears in the Style Names
drop-down list. Select romans.shx font. Set a height of 1'-0".
Keep all other parameters at their default settings.

Click Apply in the dialog box. Now Label text style is saved with
the current drawing, and becomes the current text style.

2. Using Single — Line Text

The first task is to put titles in for the floor plan and front
elevation, using the new Title text style. The titles need to be
centered approximately under each view. It we establish a vertical
guideline through the middle of the drawing; we can use it to position
the text.

Open a drawing which contains floor plan and elevation. Set
up Osnaps and Status bar such that Polar and Osnap are on
and Endpoint and Midpoint Osnaps are running. Drop a line
from the mid point of the ridgeline in the floor plan, down through
the front elevation, to a point near the bottom of the screen.
Offset the bottom line of the front step in the floor plan down 4'.

Choose Draw—>Text->Single Line Text. This will start the Dtext
command. Type j [press Enter key], all the possible justification
points appear in the prompt. Type c [press Enter key] to choose
Center as the justification.

Hold down the Shift key and click the right mouse button. A
menu of Osnap options appears on the screen, select
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Intersection on the menu and pick the intersection of the
guideline and the offset line.

For rotation, press Enter key to accept the default angle of 0°.
An “I” cursor will be positioned at the intersection. With Caps
Lock on, type floor plan [press Enter key]. The text is at the
intersection and the cursor jumps down to allow you to type
another line.

Press Enter key again to end the Dtext command. The text is
centered relative to the vertical guideline and sits on the offset
line. Offset the ground line of the elevation down 4’. Start the
Dtext command again and repeat steps 2-5 above, this time
entering front elevation (again with Caps Lock on). When
finished, erase the offset lines and the vertical guideline.

3. Placing Room Labels in the Floor Plan

Text for the room labels will use the Label text style, so you
need to make that style current before you start placing text. For
this used Dtext command by using the Style option.

Pan the drawing down and zoom into the floor plan. Click the
Polar and Osnap buttons on the Status bar to turn these features
off.

Start the Dtext command, at the prompt type s [press Enter
key] to choose the Style option. Type ? [press Enter key two
times] to see a list of defined text styles.

Type s [press Enter key], again type Label [press Enter key] to
make Label the current text style. Press F2 to close the text
screen and return to the drawing. Pick a point in the kitchen a
couple of feet below and to the left of the oven.

Press Enter key at the Rotation prompt. The text cursor appears
at the point you picked. With Caps Lock on, type Kitchen [press
Enter key], living room [press Enter key], bedroom [press Enter
key], bath [press Enter key two times], the Dtext command
ends. Now you will have four lines of text in the kitchen and
living room area.
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Now move the text to the respective rooms, Click anywhere on
the text say BATH, one grip appears at the justification point of
the text. Click the grip to activate it. The BATH text is attached
to the cursor and moves with it. The Stretch command
automatically starts. Since text can’t be stretched, the Stretch
command functions like the Move command.

Be sure that Ortho, Polar, Osnap, and Otrack are turned off.
Move the cursor to the bathroom and click a location to place
the word in such a way that the letters don’t touch any fixtures
or walls. The Move command automatically ends when you
complete a move. Repeat the procedure to move all other text.

4.Creating a Title Block and Border

The first step in creating a title block and border for the
drawing is deciding on a sheet size for printing the final drawing.
The border of the drawing will be set in from the edge of the sheet.

Create a new layer, name it as Thlkl. Leave the default color
assigned and make this layer current. Start the Rectangle
command, at the prompt, type 0,0 [press Enter key]. Then type
68’, 88’ [press Enter key]. A rectangle is drawn that extends off
the top of the screen.

At the command: prompt, click the rectangle to turn on the
grips. Grips appear at the corners of the rectangle. Click the
lower-left grip. Press the spacebar once. Then move the
rectangle over the drawing, click. Then press Esc to turn off
the grips. The rectangle is positioned around the drawing and
represents the edge of the sheet.

Offset the rectangle 3’ to the inside. Double-click the inside
rectangle. This brings up the Properties window. In this change
the Global Width of Geometry settings from 0 to 3”. Close the
dialog box and press Esc to remove the grips.

Zoom to Extents, then Zoom out a little to create a view in
which the drawing with its border nearly fills the screen. The
outer rectangle represents the edge of the sheet of paper; the
inner rectangle represents the drawing’s border.
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Title Block: The title block is a box that contains general
information about a drawing, such as the name of the project,
the design company, and the date of the drawing. It will be set
up in the lower-right corner of the border and will use the same
special line-the polyline-that was used in the Rectangle
command.

Click on the Polyline icon on the Draw toolbar. The Specify
start point: prompt appears in the Command window. Click Polar
on the Status bar and select Temporary Tracking Point Osnap.
Click the lower-left corner of the border and hold the cursor
directly above that point. When the vertical tracking path
appears along the left boundary line, type 12’ [press Enter key].
This starts a polyline on the left side of the border 12’ above
the lower-left corner.

Now set the line width to 3” by typing w at the command prompt.
Hold the crosshair cursor on the right side of the border. When
the perpendicular icon appears on the borderline, click. Then
press Enter key. The first polyline segment is drawn.

Restart the Polyline command. Choose the Midpoint Osnap
and start a new segment at the midpoint of the line already
drawn. Move to the bottom of the border near its midpoint. Run
Perpendicular Osnap is activated, click. The left edge of the
title block is drawn. Press Enter key to stop the Polyline. Trim
the left half of the first Pline drawn. Offset the horizontal Pline
down 4'. Then offset this new line down 3. Then offset this
new line down 2’-6”.

Using Midpoint Osnap, start a Pline at the midpoint of the third
horizontal line down. Then end the segment at the bottom of
the border. Trim the right side of the line just above the bottom
of the border, back to the line just drawn. The lines for the title
block are over.

Putting Text in the Title Block: First we need to put labels in
some of the boxes to identify what information will be shown
there. For this, Choose Format->Text Style. The Text Style dialog
box appears. Click New and type Tblk-label and click OK. Leave
the font set to romans.shx, but change the height to 8”. Then
click Apply & Close.
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Be sure Caps Lock is on, then type dt press Enter key to start
the Dtext command. Click the Snap to None Osnap button.
Then pick a point in the upper-left corner of the upper box of
the title block. Press Enter key at the rotation prompt. Type
project: press Enter key two times. Now PROJECT: will be
placed in the upper box. Repeat the procedure to type all other
text in the boxes. Fig. 8.7.2 shows a sample title block.

Fig. 8.7.2
PROJECT:
DRAWN BY: SHEET NO.:
DATE:
Exercise

1. Prepare a drawing with floor plan and front elevation, practice
the following:

Set up various text styles — Use Title and Label text styles
Place single-line text in the drawing for titles and room labels
Construct a title block and place text in it

8.8 Develop a 3-D drawing of a building and obtain different
views — Practice on printing on AutoCAD drawing

1. Develop a 3-D drawing of a building and obtain different
views

AutoCAD'’s 3D features are used to create either perspective
drawings or simple 3D models. A 3D computerized model of a
building that can be rotated and viewed from any angle, as well as
from the inside building. Open a drawing, which has floor plan,
make the Walls layer current and turn off all other layers. Follow
the procedure to make a 3D model:
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Choose View—-> Display-> UCS Icon-> On, the UCS Icon
appears. Now you will change the view of the plan, choose
View-> 3D Views—> SW Isometric (SW means from the
southwest). Zoom out and pan down to put the walls in 3D.

Set the Endpoint Osnap to be running, and Polar and Ortho
are turned off. Create a new layer called 3D-Walls, assign it
color 22, and make it current. Choose Draw->Solids->Box. Click
the lowest corner of the walls, and then click the uppermost
corner. Specify the height 9'. A box is drawn over the entire
floor plan.

Restart the Box command and make another 9" high box in the
living room. Pick the inside corner to the left of the front door
and the inside corner. Create a third box in the remaining part
of the living room. Make 9’ boxes at the interior corners of the
bedroom and bathroom.

Choose Modify-> Solids Editing—> Subtract. Pick the large
outside box, then press Enter key. Pick the four smaller inside
boxes and press Enter key, they are removed. Choose
View—>Hide. Hidden lines are removed and you can see solid
walls. Choose View—> Regen to restore the hidden lines.

Cutting Doorway Openings: Create a new layer called 3D-
Doors and make it current. Freeze the 3D-Walls layer. Bring
up the Solids tool bar to the screen and dock it on the right side
of the drawing area.

Make a box for the front, bedroom, and balcony door openings.
Click opposite corners of each opening, then enter 7°6 press
Enter key. Copy the front door box to the back door opening,
and the bedroom one to the bath opening.

Zoom Previous, thaw the 3D-Walls layer. Choose
Modify-> Solids Editing—> Subtract. Click the wall solid, then
press Enter key. Click the five boxes openings, and press Enter
key.

Choose View->Hide, the doorway openings have been cut.
Choose View->Regen to restore the hidden lines.

Cutting Window Openings: Create a new layer called 3D-
Windows and make it current. Freeze the 3D-Walls layer and
turn on the Windows layer.
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Use the Box command to create six box solids that are 3'-6”
high at each of the windows. Using the Move command, move
the window boxes up 4'.

Choose Modify-> Solids Editing-> Subtract. Click the wall solid,
then press Enter key. Pick the six window boxes, then press
Enter key. The window openings are cut out of the walls.

To create a circular window, click the Cylinder icon on the Solids
tool bar, use Insert Osnap to locate the center point of the 2’
window. Specify the radius for the base of the cylinder by using
Endpoint Osnap and clicking the point where one of the window
jamb lines meets the front wall.

Specify the height of the cylinder by typing 6 press Enter key.
Using Move command, Polar Tracking, and Direct Distance
entry to move the cylinder up 6.

Choose Modify->Solids Editing—> Subtract. Click the walls solid,
press Enter key, then click the round window and press Enter
key again. Figure 8.8.1 shows the finished 3D-Model of a
building.

Fig. 8.81
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2. Practice on printing an AutoCAD drawing

Now we need to print the drawing using the default system
printer, which is set up for an 8.5” x 11” — format laser-jet printer.
The first step is to assign line weights to the visible layers.
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Click Cancel to close the Plot dialog box. Then click the Layers
button on the Object Property toolbar. The Layer Properties
Manager dialog box comes up.

Click the Dim1 layer to highlight it. Hold down the Ctrl key and
click the three Hatch-elev layers and the Roof layers to select
them. Then release the Ctrl key. In the Line weight column,
click one of the highlighted Default words. Click 0.005”. Then
click OK.

Click on the Balcony layer near the layer’s name. Hold down
the Ctrl key and click on Fixtures, Headers, and Steps. Click
one of the highlighted Default words. Click 0.008”. Then click
OK. Click the Walls layer and use the same procedure to assign
a thickness of 0.014”. Click OK to close the Layer Properties
Manager box.

Now Click the Plot button on the Standard toolbar. Check the
printer, Paper Size and Paper Units. Select Window radio button
in the Plot Area of the Plot dialog box. Be sure Portrait is selected
in the Drawing Orientation area at the top.

In the Plot Scale area, open the Scale drop-down list and select
1/8” = 1'0". In the Plot offset area; click the Center the Plot
check box. Now we need to preview the printing setup.

In the Plot dialog box, click the Full Preview button; it displays
a full view of the drawing. Check the print was oriented correctly
or not. At the bottom of the Plot dialog box, click OK. The
computer will send it to the printer.
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